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Preface

Welcome to Web User Interface Developer’s Guide for Oracle Application Development
Framework!

This document is intended for developers who need to create the view layer of a web
application using the rich functionality of ADF Faces Rich Client components.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation
accessible to all users, including users that are disabled. To that end, our
documentation includes features that make information available to users of assistive
technology. This documentation is available in HTML format, and contains markup to
facilitate access by the disabled community. Accessibility standards will continue to
evolve over time, and Oracle is actively engaged with other market-leading
technology vendors to address technical obstacles so that our documentation can be
accessible to all of our customers. For more information, visit the Oracle Accessibility
Program Web site at http: //www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an
otherwise empty line; however, some screen readers may not always read a line of text
that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation

This documentation may contain links to Web sites of other companies or
organizations that Oracle does not own or control. Oracle neither evaluates nor makes
any representations regarding the accessibility of these Web sites.

Deaf/Hard of Hearing Access to Oracle Support Services

To reach Oracle Support Services, use a telecommunications relay service (TRS) to call
Oracle Support at 1.800.223.1711. An Oracle Support Services engineer will handle
technical issues and provide customer support according to the Oracle service request
process. Information about TRS is available at
http://www.fcc.gov/cgb/consumerfacts/trs.html, and a list of phone
numbers is available at http: //www. fcc.gov/cgb/dro/trsphonebk.html.
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Introduction to ADF Faces Rich Client

This chapter introduces ADF Faces rich client, providing a history, an overview of the
framework functionality, and an overview of each of the different component types
found in the library. It also introduces the ADF Faces demonstration application that
can be used in conjunction with this guide.

This chapter includes the following sections:

s Section 1.1, "Introduction to Oracle ADF Faces Rich Client"
»  Section 1.2, "Architecture of ADF Faces Components"

= Section 1.3, "ADF Faces Components"

= Section 1.4, "ADF Faces Demonstration Application"

1.1 Introduction to Oracle ADF Faces Rich Client

Oracle ADF Faces rich client (known also as ADF Faces) is a set of JavaServer Faces
(JSF) components that include built-in Asynchronous JavaScript and XML (AJAX)
functionality. While AJAX brings rich client-like functionality to browser-based
applications, using JSF provides server-side control, which reduces the amount of
JavaScript code that application developers need to write in order to implement
AJAX-based applications.

In addition to providing a rich set of JSF components, the ADF Faces rich client
framework (RCF) provides a client-side programming model familiar to developers
accustomed to the JSF development model. Most of the RCF differs little from any
standard JSF application: the server programming model is still JavaServer Faces, and
the framework still uses the JavaServer Faces lifecycle, server-side component tree,
and the expression language (EL). However, the RCF also provides a client-side
programming model and lifecycle that execute independently of the server.
Developers can find and manipulate components from JavaScript, for example get
and set properties, receive and queue events, and so forth, entirely from JavaScript.
The RCF makes sure that changes to component state are automatically synchronized
back to the server to ensure consistency of state, and that events are delivered, when
necessary, to the server for further processing.

Before providing more detailed information regarding ADF Faces, it may help to have
a brief history of the ADF Faces library and Rich Internet Applications (RIAs) and
AJAX in general.

1.1.1 History of ADF Faces

In the 1990s, software vendors began to see the need for Internet applications to
appear and behave more like desktop applications, and so they developed RIA
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frameworks on which to build these applications. However, these frameworks
required that users install proprietary plug-ins in order to utilize the functionality. As
web standards developed, and Java web applications became more prevalent, the
development community at large started to recognize the need for a standard
view-layer framework. The Java Community Process (JCP) developed JSF as a user
interface standard for Java web applications. From the formative years of JSR-127 in
2001, through the first release in 2004, and up to the current release, the JCP has
brought together resources from the community, including Oracle, to define the JSF
specification and produce a reference implementation of the specification. JSF is now
part of the Java EE standard.

With JSF being a standard for building enterprise Java view components, vendors
could now develop their own components that could run on any compliant
application server. These components could now be more sophisticated, allowing
developers to create browser-based RIAs that behaved more like thick-client
applications. To meet this need, Oracle developed a set of components called ADF
Faces that could be used on any runtime implementation of JSF. Oracle ADF Faces
provided a set of over 100 components with built-in functionality, such as data tables,
hierarchical tables, and color and date pickers, that exceeded the functionality of the
standard JSF components. To underline its commitment to the technology and the
open source community, Oracle has since donated that version of the ADF Faces
component library to the Apache Software Foundation, and it is now known as
Apache MyFaces Trinidad. This component library is currently available through the
Apache Software Foundation.

ADF Faces not only provided a standard set of complex components, pages were now
able to be partially refreshed using partial page rendering with AJAX. AJAX is a
combination of asynchronous JavaScript, dynamic HTML (DHTML), XML, and the
XmlHttpRequest communication channel, which allows requests to be made to the
server without fully rerendering the page. However, pages built solely using AJAX
require a large amount of JavaScript to be written by the developer.

The latest version of ADF Faces takes full advantage of AJAX, and it also provides a
fully-functioning framework, allowing developers to implement AJAX-based RIAs
relatively easily with a minimal amount of hand-coded JavaScript. Using ADF Faces,
you can easily build a stock trader's dashboard application that allows a stock analyst
to use drag and drop to add new stock symbols to a table view, which then gets
updated by the server model using an advanced push technology. To close new deals,
the stock trader could navigate through the process of purchasing new stocks for a
client, without having to leave the actual page. ADF Faces insulates the developer
from the need to deal with the intricacies of JavaScript and the DHTML differences
across browsers.

1.1.2 ADF Faces as Rich Client Components

ADF Faces rich client framework offers complete RIA functionality, including drag
and drop, lightweight dialogs, a navigation and menu framework, and a complete
JavaScript APL The library provides over 100 RIA components, including hierarchical
data tables, tree menus, in-page dialogs, accordion panels, dividers, and sortable
tables. ADF Faces also includes data visualization components, which are Flash- and
SVG-enabled components capable of rendering dynamic charts, graphs, gauges, and
other graphics that provide a real-time view of underlying data. Each component also
offers customizing and skinning, along with support for internationalization and
accessibility.

To achieve these capabilities, ADF Faces components use a rich JSF render kit. This kit
renders both HTML content as well as the corresponding client-side components. This
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built-in support enables you to build RIAs without needing extensive knowledge of
the individual technologies.

ADF Faces can also be used in an application that uses the Facelets library. Facelets is a
JSF-centric declarative XML view definition technology that provides an alternative to
using the JSP engine technology for the view. For more details about the architecture of
ADF Faces, see Section 1.2, "Architecture of ADF Faces Components."

Tip: You can use ADF Faces in conjunction with Oracle ADF Model
data binding, allowing you to declaratively bind ADF Faces
components to the business layer. Using ADF Model data binding,
most developer tasks that would otherwise require writing code are
declarative. However, this guide covers only using ADF Faces
components in a standard JSF application. For more information about
using ADF Faces with the ADF Model, see the Oracle Fusion
Middleware Fusion Developer’s Guide for Oracle Application Development
Framework.

In addition to an extensive library of RIA components, Oracle also offers Oracle
JDeveloper, a full-featured development environment with built-in declarative support
for ADF Faces components, allowing you to quickly and easily build the view layer of
your web application. JDeveloper contains a visual layout editor that displays JSF
pages in a WYSIWYG environment. The Component Palette in JDeveloper holds
visual representations of each of the ADF Faces components, which allows you to drag
and drop a component onto a page in the visual editor, instead of having to manually
add tag syntax to a page. You can use JDeveloper throughout the complete
development lifecycle, as it has integrated features for modeling, coding, debugging,
testing, tuning, and deploying. For more information about using JDeveloper, see
Chapter 2, "Getting Started with ADF Faces."

1.2 Architecture of ADF Faces Components

Unlike frameworks where most of the application logic resides on the client, with ADF
Faces application logic resides mostly on the server, executing in the JSF lifecycle. The
Java data model also remains on the server: the ADF Faces framework performs initial
rendering of its components on the server, generating HTML content that is consumed
directly by browsers. Rendering HTML on the server means that there is less
client-side rendering overhead, which is helpful for complex components.

Note: Because ADF Faces adheres to the standards of the JSF
technology, this guide is mostly concerned with content that is in
addition to, or different from, JSF standards. Therefore, it is
recommended that you have a basic understanding of how JSF works
before beginning to develop with ADF Faces. To learn more about JSE,
visit Sun’s web site at http://java.sun.com.

1.2.1 Client-Side Architecture

JavaScript performance can suffer when too many objects are created. To improve
performance, the RCF minimizes the number of component objects present on the
client, and the number of attributes sent to the client. The framework also has the
JavaScript files that make up the components housed in configurable partitions,
allowing your application to load only the required JavaScript.
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1.2.1.1 Client-Side Components

In JSF, as in most component-based frameworks, an intrinsic property of the
component model is that components can be nested to form a hierarchy, typically
known as the component tree. This simply means that parent components keep track of
their children, making it possible to walk over the component tree to find

all descendents of any given component. While the full component tree still exists on
the server, the ADF Faces client-side component tree is sparsely populated. Client-side
components primarily exist to add behavior to the page by exposing an API contract
for both application developers as well as for the framework itself. It is this contract
that allows, among other things, toggling the enabled state of a button on the client.
Therefore, client-side components are created only for those components that are truly
needed on the client, typically those that have been explicitly configured to have client
representation.

It is also possible for JavaScript components to be present that do not correspond to
any existing server-side component. For example, some ADF Faces components have
client-side behavior that requires popup content. These components may create
AdfRichPopup JavaScript components, even though no Java RichPopup component
may exist.

The JavaScript class that you will interact with most is AdfUIComponent and its
subclasses. An instance of this class is the client-side representation of a server-side
component. Each client component has a set of properties (key/value pairs) and a list
of listeners for each supported event type. All RCF JavaScript classes are prefixed with
Adf to avoid naming conflicts with other JavaScript libraries. For example,
RichCommandButton has AdfRichCommandButton, RichDocument has
AdfRichDocument, and so on.

While the Java UIComponent object represents the state of the component, and this
object is what you interact with to register listeners and set properties, the Renderer
handles producing HTML and receiving postbacks on behalf of the component. In the
RCEF client-side JavaScript layer, client-side components have no direct interaction with
the document object model (DOM) whatsoever. All DOM interaction goes through an
intermediary called the peer. Peers interact with the DOM generated by the Java
renderer and handle updating that state and responding to user interactions.

Peers have a number of other responsibilities, including:
= DOM initialization and cleanup

= DOM event handling

s Geometry management

= Partial page response handling

s  Child visibility change handling

1.2.1.2 JavaScript Library Partitioning

A common issue with JavaScript-heavy frameworks is determining how best to
deliver a large JavaScript code base to the client. On one extreme, bundling all code
into a single JavaScript library can result in a long download time. On the other
extreme, breaking up JavaScript code into many small JavaScript libraries can result in
a large number of roundtrips. Both approaches can result in the end user waiting
unnecessarily long for the initial page to load.

To help mitigate this issue, ADF Faces aggregates its JavaScript code into partitions. A
JavaScript library partition contains code for components and/or features that are
commonly used together. By default, ADF Faces provides a partitioning that is
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intended to provide a balance between total download size and total number of
roundtrips.

One benefit of ADF Faces's library partitioning strategy is that it is configurable.
Because different applications make use of different components and features, the
default partitioning provided by ADF Faces may not be ideal for all applications. As
such, ADF Faces allows the JavaScript library partitioning to be customized on a
per-application basis. This partitioning allows application developers to tune the
JavaScript library footprint to meet the needs of their application. For more
information about configuring JavaScript partitioning, see Section A.9, "Using
JavaScript Library Partitioning."

1.2.2 ADF Faces Architectural Features

The RCF enables many architectural features that can be used throughout your
application. For example, because processing can be done on the client, small amounts
of data can be exchanged with the server without requiring the whole page to be
rendered. This is referred to as partial page rendering (PPR). Many ADF Faces
components have PPR functionality implemented natively. For example, the

ADF Faces table component comes with built-in AJAX-style functionality that lets you
scroll through the table, sort the table by clicking a column header, mark a row or
several rows for selection, and even expand specific rows in the table, all without
requiring a roundtrip to the server, and with no coding needed. For more information,
see Chapter 7, "Rerendering Partial Page Content."

The RCF also adds functionality to the standard JSF lifecycle. Examples include a
client-side value lifecycle, a subform component that allows you to create independent
submittable regions on a page without the drawbacks of using multiple forms on a
single page, and an optimized lifecycle that can limit the parts of the page submitted
for processing. For more information, see Chapter 4, "Using the JSF Lifecycle with ADF
Faces."

The RCF uses the standard JSF event framework. However, events in the RCF have
been abstracted from the standard JavaScript DOM event model. Though the events
share some of the same abstractions found in the DOM event model, they also add
functionality. Consequently, you need not listen for click events on buttons, for
example. You can instead listen for AdfActionEvent events, which may or may not
have been caused by key or mouse events. RCF events can be configured to either
deliver or not deliver the event to the server. For more information, see Chapter 5,
"Handling Events."

ADF Faces input components have built-in validation capabilities. You set one or more
validators on a component by either setting the required attribute or by using the
prebuilt ADF Faces validators. In addition, you can create your own custom validators
to suit your business needs.

ADF Faces input components also have built-in conversion capabilities, which allow
users to enter information as a string and the application can automatically convert the
string to another data type, such as a date. Conversely, data stored as something other
than a string can be converted to a string for display and updating. Many components,
such as the inputDate component, automatically provide this capability. For more
information, see Chapter 6, "Validating and Converting Input."

In addition to these architectural features, the RCF also supports the following:

= Fully featured client-side architecture: Many of the features you need to create
AJAX-type functionality in your web application are found in the client side of the
architecture. For more information, see Chapter 3, "Using ADF Faces
Architecture.”
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= Reuse: You can create page templates, as well as page fragments and composite
components made up of multiple components, which can be used throughout
your application. For more information, see Chapter 19, "Creating and Reusing
Fragments, Page Templates, and Components.”

= Skinning: You can globally change the appearance of components. For more
information, see Chapter 20, "Customizing the Appearance Using Styles and
Skins."

= Internationalization: You can change text and other display attributes based on the
user’s locale. For more information, see Chapter 21, "Internationalizing and
Localizing Pages."

»  Accessibility: You can implement accessibility support, including keyboard
shortcuts and text descriptions. For more information, see Chapter 22,
"Developing Accessible ADF Faces Pages."

= Custom component creation: You can create your own components that use the
RCEF. For more information, see Chapter 30, "Creating Custom ADF Faces
Components."

= User customizations: You can create your pages so that they allow users to change
certain display attributes for components at runtime. For more information, see
Chapter 31, "Allowing User Customization on JSF Pages."

s Drag and drop: You can allow attribute values, collection values, or complete
components to be dragged from one component to another. For more information,
see Chapter 32, "Adding Drag and Drop Functionality."

1.3 ADF Faces Components

ADF Faces components generally fall into two categories. Layout components are
those that are used to organize the contents of the page. Along with components that
act as containers to determine the layout of the page, ADF Faces layout components
also include interactive container components that can show or hide content, or that
provide sections, lists, or empty spaces. Certain layout components support geometry
management, that is, the process by which the size and location of components appear
on a page. The RCF notifies these components of browser resize activity, and they in
turn are able to resize their children. This allows certain components to stretch or
shrink, filling up any available browser space. JDeveloper provides prebuilt
quick-start layouts that declaratively add layout components to your page based on
how you want the page to look. For more information about layout components and
geometry management, see Chapter 8, "Organizing Content on Web Pages."

The remaining components are considered to be in the common category, and are
divided into the following subcategories:

= Input components: Allow users to enter data or other types of information, such as
color selection or date selection. ADF Faces also provides simple lists from which
users can choose the data to be posted, as well as a file upload component. For
more information about input components, see Chapter 9, "Using Input
Components and Defining Forms."

= Table and tree components: Display structured data in tables or expandable trees.
ADF Faces tables provide functionality such as sorting column data, filtering data,
and showing and hiding detailed content for a row. Trees have built-in
expand/collapse behavior. Tree tables combine the functionality of tables with the
data hierarchy functionality of trees. For more information, see Chapter 10, "Using
Tables and Trees."

1-6 Web User Interface Developer's Guide for Oracle Application Development Framework



ADF Faces Components

List-of-Values (LOV) components: Allow users to make selections from lists driven
by a model that contains functionality like searching for a specific value or
showing values marked as favorites. These LOV components are useful when a
field used to populate an attribute for one object might actually be contained in a
list of other objects, as with a foreign key relationship in a database. For more
information, see Chapter 11, "Using List-of-Values Components."

Query components: Allow users to query data. ADF Faces provides two query
components. The Query component can support multiple search criteria,
dynamically adding and deleting criteria, selectable search operators, match
all/any selections, seeded or saved searches, a basic or advanced mode, and
personalization of searches. The QuickQuery component is a simplified version
of the Query component that allows a search on a single item (criterion). For more
information, see Chapter 12, "Using Query Components."

Popup components: Display data in popup windows or dialogs. The dialog
framework in ADF Faces provides an infrastructure to support building pages for
a process displayed in a new popup browser window separate from the parent
page. Multiple dialogs can have a control flow of their own. For more information,
see Chapter 13, "Using Popup Dialogs, Menus, and Windows."

Explorer-type menus and toolbars: Allow you to create menu bars and toolbars.
Menus and toolbars allow users to select from a specified list of options (in the
case of a menu) or buttons (in the case of a toolbar) to cause some change to the
application. For more information, see Chapter 14, "Using Menus, Toolbars, and
Toolboxes."

Calendar component: Displays activities in day, week, month, or list view. You can
implement popup components that allow users to create, edit, or delete activities.
For more information, see Chapter 15, "Creating a Calendar Application."

Output components: Display text and graphics, and can also play video and music
clips. ADF Faces also includes a carousel output component that can display
graphics in a revolving carousel. For more information, see Chapter 16, "Using
Output Components."

Labels, tips, and messages: Display labels for other components, along with
mouseover tips and error messages. Unlike standard JSF input components, ADF
Faces components that support messages automatically display their own
messages. You can also have components display informational content, for
example contextual help. For more information, see Chapter 17, "Displaying Tips,
Messages, and Help."

Navigation components: Allow users to go from one page to the next. ADF Faces
navigation components include buttons and links, as well as the capability to
create more complex hierarchical page flows accessed through different levels of
menus. For more information, see Chapter 18, "Working with Navigation
Components."

Data visualization components: Allow users to view and analyze complex data in
real time. ADF data visualization components include graphs, gauges, pivot
tables, geographic maps, Gantt charts, and hierarchy viewers that display
hierarchical data as a set of linked nodes, for example an organization chart. For
more information, see Chapter 23, "Introduction to ADF Data Visualization
Components."
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1.4 ADF Faces Demonstration Application

ADF Faces includes a demonstration application that allows you both to experiment
with running samples of the components and architecture features, and view the
source code.

1.4.1 How to Download and Install the ADF Faces Demo Application

In order to view the demo application (both the code and at runtime), install
JDeveloper, and then download and open the application within JDeveloper.

You can download the ADF Faces demo application from the Oracle Technology
Network (OTN) web site. Navigate to
http://www.oracle.com/technology/products/adf/adffaces/index.htm
1 and click the link for installing the ADF Faces Rich Client demo. The resulting page
provides detailed instructions for downloading the WAR file that contains the
application, along with instructions for deploying the application to a standalone
server, or for running the application using the Integrated WebLogic Server included
with JDeveloper.

If you do not want to install the application, you can run the application directly from
OTN by clicking the ADF Faces Rich Client Components Hosted Demo link.

1.4.2 Using the ADF Faces Demo Application

The demo application contains the following:

» Tag guide: Demonstrations of ADF Faces components, validators, converters, and
miscellaneous tags, along with a property editor to see how changing attribute
values affects the component. Figure 1-1 shows the demonstration of the
selectManyCheckbox component. Each demo provides a link to the associated
tag documentation.
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ADF Faces Demonstration Application

Figure 1-1 Tag Demonstration

ORACLE SelectManyCheckbo)( Demo Accessiblity  About..., Home TagDoc SkinningDemo  Skinning Docs  Visual Design Demo  Page Source  Template Source (]

markable Link

[ ]
Tag Guide Skinning Feature Demos Visual Designs Styles Commeonly Confused Components Find
Thiz is 2 test case for rich selectMany components, Select a value from the rich selectMany and use either the partial or full postback Attributes -
command button to push the value of the selectMany control into the underlying model (a bean property). The outputText will display the =
submitted value. accesskey
The value attribute in the example below is bound to a List autoSubmit []
Drinks [ coffee changed []
O+ changedDesc
==}
dientComponent []
D wine contentStyle
[ milk customizatonid
O fizz disabled []
helpTopicld
[lemonade d

partial postback immediate []
full postback inlinestyle

The submitted value was: abel | Drinks
By choosing & message type, the appropriate message will be added to the selectManyCheckbox, layout | vertical
[ none localvalueSet
[ fatal readonly []
Oerror rendered
O warning rendererType
[ confirmation reaued ]
Dinfo requiredMessageDetail
This demo shows the selectManyCheckbox inside of a popup.  Show SelectManyCheckbox e
See also: showRequired []
editableTable simple []
styleClass B

submittedValue
transient
E. Print Content :| walid

value »

= Skinning: Demonstrations of skinning on the various components. You can see, for
example, how changing style selectors affects how a component is displayed.
Figure 1-2 shows how setting certain style selectors affects the
inputNumberSpinbox component.
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Figure 1-2 Skinning Demonstration

ORACLE inpu‘tNumberSpinbo){ Demo Accessiblity  About.. Home TagDoc TagDemo SkinningDocs Page Source  Template Source ©

Skin v Settings v

Skinning = inputNumberSpinbox Demo

Feature Demos Visual Designs Styles Commeonly Confused Components Find

Tag Guide Skinning

This page demos inputhumberSpinbox’s skinning keys that are defined in the demoCompaonents skin.
~|Style Selectors
Select the styles that you wish to see displayed in the panel on the right.

Coema:al Disabled =l

? Name 1800 K§

ReadOnly 1900

[ af inputlumberSpinbox {background-color:pink}

i e

EDaf inputhlumberSpinbox: :access-key {coloriagual

s inputhumberSpinbox: :content {background-color:red}

ar inputhlumberspinbox: :label {color:red}

Oar inputiNumberSpinbox: iincrementor-icon-style { background-image:url{'/afr fgo_dwn.png’y;}
s inputhlumberSpinbox;: :decrementor-icon-style { background-image:url{'fafrfgo_dwn.png_rt
[ inputhlumberSpinbox:read-enly {background-color:yellow}

O inputiumberSpinbox:read-only: :content {background-color:purple}

[Haf inputhlumberspinbosx:read-only: :label {color:blue} y
ar inputhlumberSpinbox: disabled {background-color: 200C000}

s inputhlumberSpinbox;: disabled: ;content {backaround-calor; #00C0C0}
e inputhlumberSpinbosx: disabled: label {color: £0000C0}

£

>|Icon Selectors
>| Aliases

»|Resource Styles

E. Print Content

= Feature demos: Various pages that demonstrate different ways you can use ADF
components. For example, the File Explorer is an application with a live data
model that displays a directory structure and allows you to create, save, and move
directories and files. This application is meant to showcase the components and
features of ADF Faces in a working application, as shown in Figure 1-3. For more
information about the File Explorer application, see Section 1.4.3, "Overview of the
File Explorer Application."

1-10 Web User Interface Developer's Guide for Oracle Application Development Framework



ADF Faces Demonstration Application

Figure 1-3 File Explorer Application

ORACLE FIlE E)(p|o|’e|’ Feature Demos E Qrade Corporation Home Page  Page Source  Template Source ()

File » Edit+ View  Help »

Wl richDemo (% | Refresh Search arkable Link

My Files/Folder 1

~| %2 Folders

EA Table Tree Table List
V3 My Files

-~

[ Folderd M| Lo %DEtﬂd‘l
B3 iFalderi] Mame | Size (KB) ‘TVDE |DalE Modified Propertie:
B3 Folders [#] File1.doc 10 Document File 07/10/2009 L:21PM Properties
3 Folder3 File Lhtml 10 HTML File 07/10/2009 1:21FM Propertie]
E3 Folder+ File 1.pdf 10 POF File 07/10/2009 1:21PM Properties
3 Folders File 1.xls 10 LS File 07/10/2009 1:21PM Propertie:
(3 Folders
[ Folder7
3 Folders
(3 Foldera

r= [ Foider10

I 3 Folder11

L 3 Folder 12

1= (3 Foider13

L= [ Folder 14

L £3 Folder 15

L= [ Folder 16

r= [ Folder17

I 1 Folder18

L (3 Folder 13 o

I= P31 Enlderan

>/ @@ Search

4
-
|

Copyright () 2008, 2009, Crade and/or its affiiates. All rights reserved. About

Other pages demonstrate the main architectural features of ADF Faces, such as
layout components, AJAX postback functionality, and drag and drop. Figure 1-4
shows the demonstration on using the AutoSubmit attribute and partial page
rendering.
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Figure 1-4 Framework Demonstration

ORACLE ALItOSLIbmi‘t and PPR Accesshbilty  About.. Home PageSource Template Source O

Tag Guide Skinning Feature Demos Visual Designs Styles Commeonly Confused Components Find

In the demos on this page we show how to use autosubmit and partiaTriggers to respond to user entered values. A

Disabled

+ Explanation: In the demo below, note that the 'collate’ checkbox is being enabled and disabled based on the number of copies. If the number of copies is 1, it's disabled, but if the number of
copies is more than 1, it's enabled.
+ Implementation: This is achieved by setting a combination of autoSubmit, partialTriggers, and EL binding the disabled attribute. To view the jspx source hit the "View Page Source’ link in the top

cormer,
Mumber of copies 1 :I
Rendered

+ Explanation: In the demo below, note that the 'collate’ checkbox is being hidden and shown based on the number of copies. If the number of copies is 1, it's hidden, but if the number of copies is
more than 1, it's shown,

Implementation: This is achieved by setting a combination of autoSubmit, partialTriggers, and EL binding the rendered attribute. In this case the partialTrigger is on the parent of the component

where rendered is being toggled. This is because PPR can change content in a page by reference to & piece of the HTML's DOM and an 'id' in that HTML. When you set rendered to false, there is
no DOM at all rendered for that component - so no way to find the 'id' and the location to insert the new content when you set rendered back to 'true’. To work around this limitation, instead of

updating the component itself, update the parent. To view the jspx source hit the "View Page Source’ link in the top corner.

Mumber of copies 1 :I

.

Switcher

+ Explanation: In the demo below, note that the the search fields change depending on which ‘Media Type' radio is selected.

o Implementation: This is achieved by setting a combination of autoSubmit, partialTriggers, and EL binding the 'facetMame’ attribute of a switcher. The facet rendered by the switcher is determined
by the radio's selection. In this case the partialTrigger is on the parent of the switcher. This is because PPR can change content in 2 page by reference to a piece of the HTML's DOM and an 'id' in
that HTML. However there is no DOM at all rendered for a switcher - so no way to find the id' and the location to insert the new content. To work around this limitation, instead of updating the
component itself, update the parent. To view the jspx source hit the "View Page Source' link in the top corner,

Media Type ® Bocks

O music
Keywords
Book Author
Book Title
Condition
Reader Age

Data Switch ~

E. Print Content ‘

= Visual designs: Demonstrations of how you can use types of components in
different ways to achieve different Ul designs. Figure 1-5 shows how you can
achieve different looks for a toolbar.
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Figure 1-5 Toolbar Design Demonstration

ORACLE Toolbar Visual Design Demo

Visual Designs  Page Source  Template Source o
Toolbar Visual Design Demo

Toolbars (Global/Dark) - Two row toolbox example, containing menuBar, menu, toolbar, commandToolbarButton, commandButton, and quickQuery

Move splitter to
Objects » View = Format + - | E -

cause overflow!
| R = o R

O Ml Unfreeze & Maimize i
rch | T I
Example showing commandToolbarButtons not on a toolbar
[ [ [ uses [ o o = [
Primary /Medium Theme
Related Links
| Design - bu

Toolbars (PrimaryMedium) - Two row toolbox example, containing menuBar, menu, toolbar, commandToolbarButton, commandButton, and quickQuery
Objects + View v Format » Empt

7 R ! [Unfreeze i Maximize (2 back ! Refresh | back ! |
Search | Employes Name v ﬂ
Move splitter to cause overflow! Example showing commandToolbarButtons not on & toolbar

Z | R | & 5 [ Unfreeze | i Maximize | 7 back _ Refresh ‘ b

M = | o |

Secondary/Light Theme

Toolbars (Secondary/Light) - Twa row toolbox example, containing menuBar, menu, toolbar, commandToolbarButton, commandButton, and quickQuery

Objects + View » Format v Empty 7 R (‘! [T Unfreeze ack ! Refresh badk !

Search | Employee Mame e :I

Example showing commandToolbarButtons not on a toolbar

Aﬂ ] 5 [ unfresze | i Maximize ‘

PR etech | bock ([JBORN = | =

Default Theme

Toolbars (Default Theme) - Two row toolbox example, containing menuBar, menu, toolbar, commandToolbarButton, commandButton, and quickQuery

Objects + View + Format = Empt R (‘! [ Unfreeze agmaxim\ze b E Refresh | back !
Search 2

= Styles: Demonstration of how setting inline styles and content styles affects

components. Figure 1-6 shows different styles applied to the panelBox
component.
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Figure 1-6 Styles Demonstration

ORACLE pane|BO)( Demo Accessibiity  About.. Home TagDoc SkinmngDemo TagDema SkinmingDocs  Page Source  Template Source

ings -

panelBox Demao

Tag Guide Commeonly Confused Components Find

Skinning Feature Demos Visual Designs

This page demas the effect various contentStyle and inlineStyle parameters have on this compaonent. FIand*Crepresent inlineStyle and contentStyle, respectively.
*1 *C
PanelBox Text
= Oar Ol

Orext--=Calar-—= color:Agua;
O rext—->size—> font-size:large;
[ rext—-»Bold—> font-weight:hold;
[ text-->Decoration—= text-decaoration:line-through;
O rext-=Fant-—-» font-family:Times Mew Roman;

[ Text—=Italic—> font-stylesitalic;
Orext--=Horizontal Align--> text-align:right;

O rext—>vertical Align--> vertical-align:super;
Background-->Color--> background-color:Red

O Background--=Repeat--> background-repeat:repeat;
O Background-->Image—-= fimages/CoffeeBean.bmp
O gox—-=width—= width: 250px;

O Box--=Height--> height: 50px;

[ Box-->Border Color-- border-color:Lime;

[ 8ox—>Eorder Width—> border-width:thick;

[ ox-->Barder Style—> border-style:dotted;

[ zox—=0utline Style—-= outline-style:double;

[ sax—>0utline Calor—> outine~color:Fuchsia;

[ gox--=0utine width--> outiine-width:medium;

O Box-->Padding--> padding: 20px;

D Box--=Margin--> margin: 20px;

[ classification-—-=List Type--= list-style-type:upper-roman;

OO00Ooo0OoO0oO0o00oooooDoooooon

O classification—sList Image-—> list-style-image:none;

&) Frint Content :|

s Commonly confused components: A comparison of components that provide
similar functionality. Figure 1-7 shows the differences between the various
components that display lists.
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Figure 1-7 Commonly Confused Components

ORACLE ADF Faces RICh C|Ient Accesshbilty  About.. Home PageSource Template Source O

skin =  Settings & Bookmarkable Link

Tag Guide Skinning Feature Demos Visual Designs Styles Commonly Confused Components

Commonly Confused Components
Demenstrations of components that are often confused,

+ Secondary Windows # Choice
Compares the following components: Compares the following components:
o afidizlog o afinputComboboxListOfValues
o afipopup o afiselectOneChoice
o afinotewindow o afiinputlistOfyalues
o af:panelWindow e iabs

+ Checkboxes

Compares the following components:
Compares the following components: o afinavigationPane with hint="tabs'
o afizelectBooleanCheckbox o afipanelTabbed
o afiselectManyCheckbox Command Buttons

+ Radio Buttons Compares the following components:
Compares the following components; & aficommandButton

o af:selectBooleanRadio o af:commandToolbarButton
o afiselectOneRadio

.

1.4.3 Overview of the File Explorer Application

Because the File Explorer is a complete working application, many sections in this
guide use that application to illustrate key points, or to provide code samples. The
source for the File Explorer application can be found in the fileExplorer directory.

The File Explorer application uses the fileExplorerTemplate page template. This
template contains a number of layout components that provide the basic look and feel
for the application. For more information about layout components, see Chapter 8,
"Organizing Content on Web Pages." For more information about using templates, see
Chapter 19, "Creating and Reusing Fragments, Page Templates, and Components."

The left-hand side of the application contains a panelAccordion component that
holds two areas: the directory structure and a search field with a results table, as
shown in Figure 1-8.

Figure 1-8 Directory Structure Panel and Search Panel

® ‘Eg Folders
% ] My Files A

[ Foldern

7 Faldert

[ Folderz

= T -
~| §® Search
Al or part of the file narme

what bvpe of File? '
[ When was it modified?
= What size is it?
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You can expand and collapse both these areas. The directory structure is created using
a tree component. The search area is created using input components, a command
button, and a table component. For more information about using
panelAccordion components, see Section 8.9, "Displaying or Hiding Contents in
Accordion Panels and Tabbed Panels." For more information about using input
components, see Chapter 9, "Using Input Components and Defining Forms." For more
information about using command buttons, see Chapter 18, "Working with Navigation
Components." For more information about using tables and trees, see Chapter 10,
"Using Tables and Trees."

The right-hand side of the File Explorer application uses tabbed panes to display the
contents of a directory in either a table, a tree table or a list, as shown in Figure 1-9.

Figure 1-9 Directory Contents in Tabbed Panels

fH Table B Tree Table o list

View v | & Detach
Mame | Size (KE) [Type
@ Filed.doc 10 Document File
File0. html 10 HTML File
Filed. pdf 10 POF File
Fil0.xls 10 ¥LS File

The table and tree table have built-in toolbars that allow you to manipulate how the
contents are displayed. In the table an list, you can drag a file or subdirectory from one
directory and drop it into another. In all tabs, you can right-click a file, and from the
context menu, you can view the properties of the file in a popup window. For more
information about using tabbed panes, see Section 8.9, "Displaying or Hiding Contents
in Accordion Panels and Tabbed Panels." For more information about table and tree
table toolbars, see Section 10.8, "Displaying Table Menus, Toolbars, and Status Bars."
For more information about enabling drag and drop, see Chapter 32, "Adding Drag
and Drop Functionality." For more information about using context menus and popup
windows, see Chapter 13, "Using Popup Dialogs, Menus, and Windows."

The top of the File Explorer application contains a menu and a toolbar, as shown in
Figure 1-10.

Figure 1-10 Menu and Toolbar

File v Edit = |4
[ N W 3 v Folders

Current Location| Search

® Table

= CEE Folder Tree Table
VO MyFles |

[T Folde

3 Folder Refresh
3 Folder2

The menu options allow you to create and delete files and directories and change how
the contents are displayed. The Help menu opens a help system that allows users to
provide feedback in dialogs, as shown in Figure 1-11.
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Figure 1-11 Help System

oo T

Speak with a FileExplorer.com Cust

We're available 24 hours a day, 7 days a week, 365 davs a year

Let us know a good time to call you, and we'll have a customer service representative contact you.

Pick a date and time for us to call you ﬁ"@ (UTC-08:00) US Pacific Time

» Phone number where we should call you Extension

% Alternate phone number Exctension

The help system consists of a number of forms created with various input components,
including a rich text editor. For more information about menus, see Section 14.2,
"Using Menus in a Menu Bar." For more information about creating help systems, see
Section 17.5, "Displaying Help for Components." For more information about input
components, see Chapter 9, "Using Input Components and Defining Forms."

Within the toolbar of the File Explorer are controls that allow you navigate within the
directory structure, as well as controls that allow you to change the look and feel of the
application by changing its skin. Figure 1-12 shows the File Explorer application using
the simple skin.

Figure 1-12 File Explorer Application with the Simple Skin

Logo Here File Explorer

Tag Guide | [8 Oracle Corporation Home Page OJ

File~

Edit~  iew

Help~ ~

_J_) 3 | Select Skin |Simp|e

hd Refreshl | Vl |Search

Current Location: |N0ne

£

= = Folders

= 3 My Files
(3 Folderd
3 Foldert
(3 Folder2
3 Folder3

PO Celdad

s Tahle”EI Tree TahIeHEE List|

“Wiewr v

Mame Date Modifie

Mo File ltem

| Size (<B)] Type

=@ Search

All or part of the file name

| |
hat type of File?

= When was it modified?
- What size is it?

Search I

There were no files found

S

Name |Type |Size (KB)

[File Pat
4

< |

>

For more information about toolbars, see Section 14.3, "Using Toolbars." For more
information about using skins, see Chapter 20, "Customizing the Appearance Using

Styles and Skins."

1.4.4 Viewing the Source Code In JDeveloper

All the source files for the ADF Faces demo application are contained in one project
(you give this project a name when you create it during installation). The project is
divided into two directories: Application Sources and Web Content. Application
Sources contains the oracle.adfdemo.view package, which in turn contains
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packages that hold managed beans that provide functionality throughout the
application.

Tip: The managed beans for the component demos are in the
component package and the managed beans for the File Explorer
application are in the explorer package.

The Web Content directory contains all the web resources used by the application,
including JSPX files, JavaScript libraries, images, configuration files, and so on.

Tip: The components subdirectory contains the resources for the
component demos. The docs directory contains the tag and Javadoc
documentation. The £ileExplorer directory contains the resources
for the File Explorer application.
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Getting Started with ADF Faces

This chapter describes how to use JDeveloper to declaratively create ADF Faces
applications.

This chapter includes the following sections:

= Section 2.1, "Developing Declaratively in JDeveloper"
»  Section 2.2, "Creating an Application Workspace"

»  Section 2.3, "Defining Page Flows"

= Section 2.4, "Creating a View Page"

= Section 2.5, "Creating EL Expressions"

»  Section 2.6, "Creating and Using Managed Beans"

»  Section 2.7, "Viewing ADF Faces Source Code and Javadoc"

2.1 Developing Declaratively in JDeveloper

Using JDeveloper 11¢ with Oracle ADF Faces and JSF provides a number of areas
where page and managed bean code is generated for you declaratively, including
creating EL expressions and automatic component binding. Additionally, there are a
number of areas where XML metadata is generated for you declaratively, including
metadata that controls navigation and configuration.

At a high level, the development process for an ADF Faces view project usually
involves the following:

s Creating an application workspace

= Designing page flows

= Designing and creating the pages using either JavaServer Pages (JSPs) or Facelet
pages

Ongoing tasks throughout the development cycle will probably include the following:

s Creating managed beans

s Creating and using EL expressions

= Viewing ADF Faces source code and Javadoc

JDeveloper also includes debugging and testing capabilities. For more information, see
the "Testing and Debugging ADF Components" chapter of the Oracle Fusion Middleware
Fusion Developer’s Guide for Oracle Application Development Framework.
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2.2 Creating an Application Workspace

The first steps in building a new application are to assign it a name and to specify the
directory where its source files will be saved. By creating an application using
application templates provided by JDeveloper, you automatically get the organization
of your workspace into projects, along with many of the configuration files and
libraries required by the type of application you are creating.

2.2.1 How to Create an Application Workspace

You create an application workspace using the Create Application wizard.

To create an application:

1.

In the JDeveloper main menu, choose File > New.

The New Gallery opens, where you can select different application components to
create.

In the New Gallery, expand the General node, select Applications and then Java
EE Web Application, and click OK.

This template provides the building blocks you need to create a web application
that uses JSF for the view and Enterprise JavaBean (E]B) session beans and Java
Persistence API (JPA) entities for business services. All the files and directories for
the business layer of your application will be stored in a project that by default is
named Model. All the files and directories for your view layer will be stored in a
project that by default is named ViewController.

Note: This document covers only how to create the ADF Faces
project in an application, without regard to the business services used
or the binding to those services. For information about how to use
ADF Faces with the ADF Model layer, the ADF Controller, and ADF
Business Components, see the Oracle Fusion Middleware Fusion
Developer’s Guide for Oracle Application Development Framework.

In the Create Java EE Web Application dialog, set a name, directory location, and
package prefix of your choice and click Next.

In the Name Your Project page, you can optionally change the name and location
for your web project. On the Project Technologies tab, double-click ADF Faces to
move that technology to the Selected pane. This automatically adds the necessary
libraries and metadata files to your web project. Click Next.

In the Configure Java Settings page, optionally change the package name, Java
source path, and output directory for your view layer. Click Next.

In the Name Your Project page, you can optionally change the name and location
for your Java project. By default, the necessary libraries and metadata files for Java
EE are already added to your data model project. Click Next.

In the Configure Java Settings page, optionally change the package name, Java
source path, and output directory for your model layer. Click Next.

Configure the E]B settings as needed. For help on this page, click Help or press F1.
Click Finish.
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2.2.2 What Happens When You Create an Application Workspace

Figure 2-1 New

 Oracle JDeveloper, 112

When you create an application workspace using the Java EE Web Application
template, JDeveloper creates a project named Model that will contain all the source
files related to the business services in your application. JDeveloper automatically
adds the libraries needed for your EJB project. For example, if you kept the default EJB
settings, JDeveloper adds the EJB 3.0 library.

JDeveloper also creates a project named ViewController that will contain all the
source files for your ADF Faces view layer. JDeveloper automatically creates the JSF
and ADF configuration files needed for the application. Additionally, JDeveloper adds
the following libraries to your view project:

= JSF12
= JSTL1.2
= JSP Runtime

The ADF Faces and other runtime libraries are added when you create a JSF page in
your project.

Once the projects are created for you, you can rename them. Figure 2-1 shows the
workspace for a new Java EE Web application.

Workspace for an ADF Application

npphcatinn Mavigator
. Application19
7 Projects & & -
Model
=] WigwContraller
B[] web Content
-] WEB-INF

l% web.xml

D Page Flows

[+ Application Resaurces

I» Recently Opened Files

:E Application Server - Struckure

Terminating IntegratedyeblogicServer,

File Edit Yiew Application Refactor Search MNavigate Build Run VYersioning Tools Window Help

Goag 9 XEER OQO- O 8- :dda- -84 (8- )
E] npplicatinnlg Overview E] @Re;nurce Palette E]
A4 = v. = r = ~
Java Files @ - dB- B)
) les: - - ~ =/
o= #ML Files Javafiles: - - * /XK | v [ My Catalogs
Offline Databases Skatus Gl Broic e  IDE Connections
Page Flows = | pplication Server

E faces-config.xml

I Data Cantrals [

Development Build - Application1%. jws : Model. jpr |Z||E‘E|

‘Web Pages

Web Services
Business Components
Binding Files

Enterprise JavaBeans 3.0

]

uf Editing,

JDeveloper also sets configuration parameters in the configuration files based on the
options chosen when you created the application. In the web . xm1 file, these are
configurations needed to run a JSF application (settings specific to ADF Faces are
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added when you create a JSF page with ADF Faces components). Example 2-1 shows
the web . xm1 file generated by JDeveloper when you create a new Java EE application.

Example 2-1 Generated web.xml File

<?xml version = '1.0' encoding = 'windows-1252'?>
<web-app xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemalocation="http://java.sun.com/xml/ns/javaee
http://java.sun.com/xml/ns/javaee/web-app_2_5.xsd" version="2.5"
xmlns="http://java.sun.com/xml/ns/javaee">
<description>Empty web.xml file for Web Application</description>
<servlet>
<servlet-name>Faces Servlet</servlet-name>
<servlet-class>javax.faces.webapp.FacesServlet</servlet-class>
<load-on-startup>1</load-on-startup>
</servlet>
<servlet-mapping>
<servlet-name>Faces Servlet</servlet-name>
<url-pattern>/faces/*</url-pattern>
</servlet-mapping>
</web-app>

Configurations required for specific ADF Faces features are covered in the respective
chapters of this guide. For example, any configuration needed in order to use the
Change Persistence framework is covered in Chapter 31, "Allowing User
Customization on JSF Pages." For comprehensive information about configuring an
ADF Faces application, see Appendix A, "ADF Faces Configuration."

2.3 Defining Page Flows

Once you create your application workspace, often the next step is to design the flow
of your Ul As with standard JSF applications, ADF Faces applications use navigation
cases and rules to define the page flow. These definitions are stored in the
faces-config.xml file. JDeveloper provides a diagrammer through which you can
declaratively define your page flow using icons.

Figure 2-2 shows the navigation diagram created for a simple page flow that contains
two pages: a DisplayCustomer page that shows data for a specific customer, and an
EditCustomer page that allows a user to edit the customer information. There is one
navigation rule that goes from the display page to the edit page and one navigation
rule that returns to the display page from the edit page.

Figure 2-2 Navigation Diagram in JDeveloper

edit

v

"

haclk
IDisplay Customer. jspx IEditCustomer jspx
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Note: If you plan on using Oracle ADF Model data binding and the
ADF Controller, then instead of using standard JSF navigation rules,
you use task flows. For more information, see the "Getting Started
With ADF Task Flows" chapter of the Oracle Fusion Middleware Fusion
Developer’s Guide for Oracle Application Development Framework.

Best Practice: The ADF Controller extends the JSF default controller.
While you can technically use the JSF controller and ADF Controller in
your application, you should use only one or the other.

For more information on how navigation works in a JSF application, see the Java EE 5
tutorial on Sun’s web site (http://java.sun.com).

2.3.1 How to Define a Page Flow

You use the navigation diagrammer to declaratively create a page flow using JSP or
JSPX pages. When you use the diagrammer, JDeveloper creates the XML metadata
needed for navigation to work in your application in the faces-config.xml file.

Note: The diagrammer supports only pages created as JSP and JSPX
files. If you need to create navigation for XHTML pages, you must
code the XML manually.

To create a page flow:

1. In the Application Navigator, double-click the faces-config.xml file for your
application. By default, this is in the Web Content/WEB-INF node.

2. In the editor window, click the Diagram tab to open the navigation diagrammer.

3. If the Component Palette is not displayed, from the main menu choose View >
Component Palette. By default, the Component Palette is displayed in the upper
right-hand corner of JDeveloper.

4. In the Component Palette, use the dropdown menu to choose JSF Diagram
Objects.

The components are contained in two accordion panels: Components and
Diagram Annotations. Figure 2-3 shows the Component Palette displaying JSF
navigation components.
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Figure 2-3 Component Palette in JDeveloper
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5. Select the component you wish to use and drag it onto the diagram.

JDeveloper redraws the diagram with the newly added component.

Tip: You can also use the overview editor to create navigation rules
and navigation cases by clicking the Overview tab. Press F1 for details
on using the overview editor to create navigation.

Additionally, you can manually add elements to the
faces-config.xml file by directly editing the page in the source
editor. To view the file in the source editor, click the Source tab.

Once the navigation for your application is defined, you can create the pages and add
the components that will execute the navigation. For more information about using
navigation components on a page, see Chapter 18, "Working with Navigation
Components."

2.3.2 What Happens When You Use the Diagrammer to Create a Page Flow

When you use the diagrammer to create a page flow, JDeveloper creates the associated
XML entries in the faces-config.xml file. Example 2-2 shows the XML generated
for the navigation rules displayed in Figure 2-2.

Example 2-2 Navigation Rules in faces-config.xml

<navigation-rule>
<from-view-id>/DisplayCustomer.jspx</from-view-id>
<navigation-case>
<from-outcome>edit</from-outcome>
<to-view-id>/EditCustomer.jspx</to-view-id>
</navigation-case>
</navigation-rule>
<navigation-rule>
<from-view-id>/EditCustomer</from-view-id>
<navigation-case>
<from-outcome>back</from-outcome>
<to-view-id>/DisplayCustomer</to-view-id>
</navigation-case>
</navigation-rule>
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2.4 Creating a View Page

From the page flows you created during the planning stages, you can double-click the
page icons to create the actual JSP files. When you create a JSP for an ADF Faces
application, you can choose to create an XML-based JSP document (which uses the
extension * . jspx) rather than a * . jsp file.

Best Practice: Using an XML-based document has the following
advantages:

= It simplifies treating your page as a well-formed tree of Ul
component tags.

s It discourages you from mixing Java code and component tags.

= Itallows you to easily parse the page to create documentation or
audit reports.

If you want to use Facelets instead of JSP in your application, you can instead create
XHTML files. Facelets is a JSF-centric declarative XML view definition technology that
provides an alternative to using the JSP engine.

Best Practice: Use Facelets to take advantage of the following:

s The Facelets layer was created specifically for JSE, which results in
reduced overhead and improved performance during tag
compilation and execution.

= Facelets is considered the primary view definition technology in
JSF 2.0.

= Some future performance enhancements will only be available
with Facelets

ADF Faces provides a number of components that you can use to define the overall
layout of a page. JDeveloper contains predefined quick start layouts that use these
components to provide you with a quick and easy way to correctly build the layout.
You can choose from one, two, or three column layouts, and then determine how you
want the columns to behave. For example, you may want one column’s width to be
locked, while another column stretches to fill available browser space. Figure 2—4
shows the quick start layouts available for a two-column layout with the second
column split between two panes. For more information about the layout components,
see Chapter 8, "Organizing Content on Web Pages."
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Figure 2-4 Quick Layouts
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Along with adding layout components, you can also choose to apply a theme to the
chosen quick layout. These themes add color styling to some of the components used
in the quick start layout. To see the color and where it is added, see Appendix D,
"Quick Start Layout Themes." For more information about themes, see Section 20.3.4,
"How to Apply Themes to Components."

When you know you want to use the same layout on many pages in your application,
ADF Faces allows you to create and use predefined page templates. When creating
templates, the template developer can not only determine the layout of any page that
will use the template (either by selecting a quick layout design, as shown in

Figure 24, or by building it manually) but can also provide static content that must
appear on all pages, as well as create placeholder attributes that can be replaced with
valid values for each individual page. For example, ADF Faces ships with the Oracle
Three-Column-Layout template. This template provides areas for specific content,
such as branding, a header, and copyright information, and also displays a static logo
and busy icon, as shown in Figure 2-5.
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Figure 2-5 Oracle Three Column Layout Template
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Whenever a template is changed, for example if the layout changes, any page that uses
the template will also be automatically updated. For more information about creating
and using templates, see Section 19.3, "Using Page Templates."

At the time you create a JSF page, you can also choose to create an associated backing
bean for the page. Backing beans allow you to access the components on the page
programmatically. For more information about using backing beans with JSF JSP
pages, see Section 2.4.3, "What You May Need to Know About Automatic Component
Binding."

Best Practice: Create backing beans only for pages that contain com-
ponents that must be accessed and manipulated programmatically.
Use managed beans instead if you need only to provide additional
functionality accessed through EL expressions on component
attributes (such as listeners). :

You can also choose to have your page available for display in mobile devices. Once
your page files are created, you can add UI components and work with the page
source.

2.4.1 How to Create JSF JSP Pages
You create JSF JSP pages using the Create JSF Page dialog.

To create a JSF JSP page:

1. In the Application Navigator, right-click the directory where you would like the
page to be saved, and choose New. In the New Gallery, expand the Web Tier
node, select JSF and then JSF Page, and click OK.

OR

From a navigation diagram, double-click a page icon for a page that has not yet
been created.
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2. Complete the Create JSF Page dialog. For help, click Help in the dialog. For more
information about the Page Implementation option, which can be used to
automatically create a backing bean and associated bindings, see Section 2.4.3,
"What You May Need to Know About Automatic Component Binding."

2.4.2 What Happens When You Create a JSF JSP Page

When you use the Create JSF Page dialog to create a JSF page, JDeveloper creates the
physical file and adds the code necessary to import the component libraries and
display a page. The code created depends on whether or not you chose to create a

. Jspx document. Example 2-3 shows a . jspx page when it is first created by
JDeveloper.

Example 2-3 Declarative Page Source Created by JDeveloper

<?xml version='1.0' encoding='windows-1252"'?>
<jsp:root xmlns:jsp="http://java.sun.com/JSP/Page" version="2.1"
xmlns:f="http://java.sun.com/jsf/core"
xmlns:h="http://java.sun.com/jsf/html"
xmlns:af="http://xmlns.oracle.com/adf/faces/rich">
<jsp:directive.page contentType="text/html;charset=windows-1252"/>
<f:view>
<af:document id="dl">
<af:form id="fl"></af:form>
</af:document>
</f:view>
</jsp:root>

If you chose to use one of the quick layouts, then JDeveloper also adds the components
necessary to display the layout. Example 2—4 shows the generated code when you
choose a two-column layout, where the first column is locked and the second column
stretches to fill up available browser space, and you also choose to apply themes.

Example 2-4 Two-Column Layout

<?xml version='1.0' encoding='windows-1252"'?>
<jsp:root xmlns:jsp="http://java.sun.com/JSP/Page" version="2.1"
xmlns:f="http://java.sun.com/jsf/core"
xmlns:h="http://java.sun.com/jsf/html"
xmlns:af="http://xmlns.oracle.com/adf/faces/rich">
<jsp:directive.page contentType="text/html;charset=windows-1252"/>
<f:view>
<af:document id="dl">
<af:form id="f1">
<af:panelStretchLayout startWidth="100px" id="psll">
<f:facet name="start"/>
<f:facet name="center">
<!-- id="af_twocol_left_sidebar_stretched" -->
<af:decorativeBox theme="dark" id="db2">
<f:facet name="center">
<af:decorativeBox theme="medium" id="dbl">
<f:facet name="center"/>
</af:decorativeBox>
</f:facet>
</af:decorativeBox>
</f:facet>
</af:panelStretchLayout>
</af:form>
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</af:document>
</f:view>
</jsp:root>

If you chose to automatically create a backing bean using the Page Implementation
section of the dialog, JDeveloper also creates and registers a backing bean for the page,
and binds any existing components to the bean. Example 2-5 shows the code created
for a backing bean for a page.

Example 2-5 Declarative Backing Bean Source Created by JDeveloper
package view.backing;

import oracle.adf.view.rich.component.rich.RichDocument;
import oracle.adf.view.rich.component.rich.RichForm;

public class MyFile {
private RichForm f1;
private RichDocument dl;

public void setFl(RichForm f1) {
this.fl = f1;
}

public RichForm getF1() {
return f1;

}

public void setDl (RichDocument dl) ({
this.documentl = di;
}

public RichDocument getD1() {
return dl;

}

Tip: You can access the backing bean source from the JSF page by
right-clicking the page in the editor, and choosing Go to and then
selecting the bean from the list.

Additionally, JDeveloper adds the following libraries to the view project:

s ADF Faces Runtime 11

= ADF Common Runtime

= ADF DVT Faces Runtime

s Oracle JEWT

s ADF DVT Faces Databinding Runtime

JDeveloper also adds entries to the web.xm1 file, as shown in Example 2-6.

Example 2-6 Code in the web.xml File After a JSF JSP Page is Created

<?xml version = '1.0' encoding = 'windows-1252'?>
<web-app xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemaliocation="http://java.sun.com/xml/ns/javaee
http://java.sun.com/xml/ns/javaee/web-app_2_5.xsd"
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version="2.5" xmlns="http://java.sun.com/xml/ns/javaee">
<context-param>
<param-name>javax.faces.STATE_SAVING_METHOD</param-name>
<param-value>client</param-value>
</context-param>
<context-param>
<param-name>org.apache.myfaces.trinidad.CHECK_FILE_MODIFICATION</param-name>
<param-value>false</param-value>
</context-param>
<context-param>
<param-name>oracle.adf.view.rich.versionString.HIDDEN</param-name>
<param-value>false</param-value>
</context-param>
<filter>
<filter-name>trinidad</filter-name>
<filter-class>org.apache.myfaces.trinidad.webapp.TrinidadFilter</filter-class>
</filter>
<filter-mapping>
<filter-name>trinidad</filter-name>
<servlet-name>Faces Servlet</servlet-name>
<dispatcher>FORWARD</dispatcher>
<dispatcher>REQUEST</dispatcher>
</filter-mapping>
<servlet>
<servlet-name>Faces Servlet</servlet-name>
<servlet-class>javax.faces.webapp.FacesServlet</servlet-class>
<load-on-startup>1</load-on-startup>
</servlet>
<servlet>
<servlet-name>resources</servlet-name>
<servlet-class>
org.apache.myfaces.trinidad.webapp.ResourceServlet
</servlet-class>
</servlet>
<servlet>
<servlet-name>BIGRAPHSERVLET</servlet-name>
<servlet-class>
oracle.adfinternal.view.faces.bi.renderkit.graph.GraphServlet
</servlet-class>
</servlet>
<servlet>
<servlet-name>BIGAUGESERVLET</servlet-name>
<servlet-class>
oracle.adfinternal.view.faces.bi.renderkit.gauge.GaugeServlet
</servlet-class>
</servlet>
<servlet>
<servlet-name>MapProxyServlet</servlet-name>
<servlet-class>
oracle.adfinternal.view.faces.bi.renderkit.geoMap.servlet.MapProxyServlet
</servlet-class>
</servlet>
<servlet>
<servlet-name>GatewayServlet</servlet-name>
<servlet-class>
oracle.adfinternal.view.faces.bi.renderkit.graph.FlashBridgeServlet
</servlet-class>
</servlet>
<gservlet-mapping>
<servlet-name>Faces Servlet</servlet-name>
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<url-pattern>/faces/*</url-pattern>

</servlet-mapping>

<gservlet-mapping>
<servlet-name>resources</servlet-name>
<url-pattern>/adf/*</url-pattern>

</servlet-mapping>

<servlet-mapping>
<servlet-name>resources</servlet-name>
<url-pattern>/afr/*</url-pattern>

</servlet-mapping>

<servlet-mapping>
<servlet-name>BIGRAPHSERVLET</servlet-name>
<url-pattern>/servlet/GraphServlet/*</url-pattern>

</servlet-mapping>

<servlet-mapping>
<servlet-name>BIGAUGESERVLET</servlet-name>
<url-pattern>/servlet/GaugeServlet/*</url-pattern>

</servlet-mapping>

<servlet-mapping>
<servlet-name>MapProxyServlet</servlet-name>
<url-pattern>/mapproxy/*</url-pattern>

</servlet-mapping>

<servlet-mapping>
<servlet-name>resources</servlet-name>
<url-pattern>/bi/*</url-pattern>

</servlet-mapping>

<servlet-mapping>
<servlet-name>GatewayServlet</servlet-name>
<url-pattern>/flashbridge/*</url-pattern>

</servlet-mapping>

</web-app>

In the faces-config.xml file, when you create a JSF JSP page, JDeveloper creates an
entry that defines the default render kit (used to display the components in an HTML
client) for ADF Faces, as shown in Example 2-7.

Example 2-7 Generated faces-config.xml File

<?xml version="1.0" encoding="windows-1252"7?>
<faces-config version="1.2" xmlns="http://java.sun.com/xml/ns/javaee">
<application>
<default-render-kit-id>oracle.adf.rich</default-render-kit-id>
</application>
</faces-config>

An entry in the trinidad-config.xml file defines the default skin used by the user
interface (UI) components in the application, as shown in Example 2-8.

Example 2-8 Generated trinidad-config.xml File

<?xml version="1.0" encoding="windows-1252"7?>

<trinidad-config xmlns="http://myfaces.apache.org/trinidad/config">
<skin-family>fusion</skin-family>

</trinidad-config>

When the page is first displayed in JDeveloper, it is displayed in the visual editor
(accessed by clicking the Design tab), which allows you to view the page in a
WYSIWYG environment. You can also view the source for the page in the source editor
by clicking the Source tab. The Structure window located in the lower left-hand corner
of JDeveloper, provides a hierarchical view of the page.
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2.4.3 What You May Need to Know About Automatic Component Binding

Backing beans are managed beans that contain logic and properties for Ul components
on a JSF page (for more information about managed beans, see Section 2.6, "Creating
and Using Managed Beans"). If when you create your JSF JSP page you choose to
automatically expose Ul components by selecting one of the choices in the Page
Implementation option of the Create JSF Page dialog, JDeveloper automatically creates
a backing bean (or uses a managed bean of your choice) for the page. For each
component you add to the page, JDeveloper then inserts a bean property for that
component, and uses the binding attribute to bind component instances to those
properties, allowing the bean to accept and return component instances.

Specifically, JDeveloper does the following when you use automatic component

binding:

»  Creates a JavaBean using the same name as the JSP or JSPX file, and places it in the
view.backing package (if you elect to have JDeveloper create a backing bean).

s Creates a managed bean entry in the faces-config.xml file for the backing
bean. By default, the managed bean name is backing_<page_name> and the
bean uses the request scope (for more information about scopes, see Section 4.6,
"Object Scope Lifecycles").

Note: JDeveloper does not create managed bean property entries in
the faces-config.xml file. If you wish the bean to be instantiated
with certain property values, you must perform this configuration in
the faces-config.xml file manually. For more information, see

Section A.3.1, "How to Configure for ADF Faces in faces-config.xml."

= On the newly created or selected bean, adds a property and accessor methods for
each component tag you place on the JSP. JDeveloper binds the component tag to
that property using an EL expression as the value for its binding attribute.

s Deletes properties and methods for any components deleted from the page.

Once the JSP is created and components added, you can then declaratively add
method binding expressions to components that use them by double-clicking the
component in the visual editor, which launches an editor that allows you to select the
managed bean and method to which you want to bind the attribute. When automatic
component binding is used on a JSP and you double-click the component, skeleton
methods to which the component may be bound are automatically created for you in
the page’s backing bean. For example, if you add a command button component and
then double-click it in the visual editor, the Bind Action Property dialog displays the
page’s backing bean along with a new skeleton action method, as shown in Figure 2-6.

Figure 2—-6 Bind Action Property Dialog
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You can select from one these methods, or if you enter a new method name,
JDeveloper automatically creates the new skeleton method in the page's backing bean.
You must then add the logic to the method.

Note: When automatic component binding is not used on a JSP, you
must select an existing managed bean or create a new backing bean to
create the binding.

For example, suppose you created a JSP with the file name myfile. jspx. If you
chose to let JDeveloper automatically create a default backing bean, then JDeveloper
creates the backing bean as view.backing.MyFile. java, and places it in the \src
directory of the ViewController project. The backing bean is configured as a
managed bean in the faces-config.xml file, and the default managed bean name is
backing myfile.

Example 2-9 shows the code on a JSP that uses automatic component binding, and
contains form, inputText, and commandButton components.

Example 2-9 JSF Page Code with Automatic Component Binding

<f:view>
<af:document id="dl" binding="#{backing myfile.dl}">
<af:form id="f1" binding="#{backing myfile.f1l}">
<af:inputText label="Label 1" binding="#{backing_MyFile.inputTextl}"
id="inputTextl"/>
<af:commandButton text="commandButton 1"
binding="#{backing MyFile.cbl}"
id="cbl"/>
</af:form>
</af :document>
</f:view>

Example 2-10 shows the corresponding code on the backing bean.

Example 2-10 Backing Bean Code Using Automatic Component Binding

package view.backing;

import oracle.adf.view.rich.component.rich.RichDocument;

import oracle.adf.view.rich.component.rich.RichForm;

import oracle.adf.view.rich.component.rich.input.RichInputText;
import oracle.adf.view.rich.component.rich.nav.RichCommandButton;

public class MyFile {
private RichForm f1;
private RichDocument dl;
private RichInputText inputTextl;
private RichCommandButton cbl;

public void setForml (RichForm f1) {

this.forml = f1;

public RichForm getF1() ({
return f1;

public void setDl (RichDocument dl) {

Getting Started with ADF Faces 2-15



Creating a View Page

this.dl = di;

public RichDocument getD1() {
return dil;

public void setItl(RichInputText inputTextl) {
this.inputTextl = inputTextl;

public RichInputText getInputTextl () {
return inputTextl;

public void setCbl (RichCommandButton cbl) {
this.commandButtonl = commandButtonl;

public RichCommandButton getCbl () {
return cbl;

public String cbl_action() {
// Add event code here...
return null;

}

Example 2-11 shows the code added to the faces-config.xml file to register the
page’s backing bean as a managed bean.

Example 2-11 Registration for a Backing Bean

<managed-bean>
<managed-bean-name>backing MyFile</managed-bean-name>
<managed-bean-class>view.backing.MyFile</managed-bean-class>
<managed-bean-scope>request</managed-bean-scope>

</managed-bean>

In addition, when you edit a Java file that is a backing bean for a JSP, a method binding
toolbar appears in the source editor for you to bind appropriate methods quickly and
easily to selected components in the page. When you select an event, JDeveloper
creates the skeleton method for the event, as shown in Figure 2-7.
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Figure 2-7 You Can Declaratively Create Skeleton Methods in the Source Editor
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Once you create a page, you can turn automatic component binding off or on, and you
can also change the backing bean to a different Java class. Open the JSP in the visual
Editor and from the JDeveloper menu, choose Design > Page Properties. Here you can
select or deselect the Auto Bind option, and change the managed bean class. Click
Help for more information about using the dialog.

Note: If you turn automatic binding off, nothing changes in the
binding attributes of existing bound components in the page. If you
turn automatic binding on, all existing bound components and any
new components that you insert are bound to the selected managed
bean. If automatic binding is on and you change the managed bean
selection, all existing bindings and new bindings are switched to the
new bean.

You can always access the backing bean for a JSP from the page editor by right-clicking
the page, choosing Go to, and then choosing the bean from the list of beans associated
with the JSP.

2.4.4 How to Create a Facelets XHTML Page
You use the Create Facelets Page dialog to create the XHTML file.

To create an XHTML page:

1. In the Application Navigator, right-click the directory where you would like the
page to be saved, and choose New. In the New Gallery, expand the Web Tier
node, select Facelets and then Facelets Page and click OK.

Tip: Click the All Technologies tab in the New Gallery if Facelets is
not a listed technology.
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2. Complete the Create Facelets Page dialog. For help, click Help in the dialog.

2.4.5 What Happens When You Create a JSF XHTML Page

When you use the Create Facelets Page dialog to create an XHTML page, JDeveloper
creates the physical file and adds the code necessary to import the component libraries
and display a page. Example 2-3 shows an .xthml page when it is first created by
JDeveloper.

Example 2-12 Declarative Page Source Created by JDeveloper

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EE"
"http://www.w3.org/TR/xhtml1/DTD/xhtall-transitional.dtd">
<f:view xmlns="http://www.w3.0rg/1999/xhtml"
xmlns:f="http://java.sun.com/jsf/core"
xmlns:h="http://java.sun.com/jsf/html"
xmlns:af="http://xmlns.oracle.com/adf/faces/rich">
<af:document>
<af:form/>
</af:document>
</f:view>

Additionally, JDeveloper adds the following libraries to the view project:
= Facelets Runtime

s ADF Faces Runtime 11

s ADF Common Runtime

s ADF DVT Faces Runtime

s Oracle JEWT

s ADF DVT Faces Databinding Runtime

JDeveloper also adds entries to the web . xm1 file, as shown in Example 2-13.

Example 2-13 Code in the web.xml File After a JSF XHTML Page is Created

<?xml version = '1.0' encoding = 'windows-1252'?>
<web-app xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemaliocation="http://java.sun.com/xml/ns/javaee
http://java.sun.com/xml/ns/javaee/web-app_2_5.xsd"
version="2.5" xmlns="http://java.sun.com/xml/ns/javaee">
<context-param>
<param-name>javax.faces.STATE_SAVING_METHOD</param-name>
<param-value>client</param-value>
</context-param>
<context-param>
<param-name>org.apache.myfaces.trinidad.CHECK_FILE_MODIFICATION</param-name>
<param-value>false</param-value>
</context-param>
<context-param>
<param-name>oracle.adf.view.rich.versionString.HIDDEN</param-name>
<param-value>false</param-value>
</context-param>
<context-param>
<param-name>org.apache.myfaces.trinidad.FACELETS_VIEW_MAPPINGS</param-name>
<param-value>*.xhtml</param-value>
</context-param>
<context-param>
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<param-name>facelets.SKIP_XML_INSTRUCTIONS</param-name>
<param-value>true</param-value>
</context-param>
<context-param>
<param-name>org.apache.myfaces.trinidad.ALTERNATE_VIEW_HANDLER</param-name>
<param-value>
org.apache.myfaces.trinidadinternal.facelets.TrinidadFaceletViewHandler
</param-value>
</context-param>
<context-param>
<param-name>facelets.DEVELOPMENT</param-name>
<param-value>true</param-value>
</context-param>
<context-param>
<param-name>facelets.SKIP_COMMENTS</param-name>
<param-value>true</param-value>
</context-param>
<context-param>
<param-name>facelets.DECORATORS</param-name>
<param-value>
oracle.adfinternal.view. faces.facelets.rich.AdfTagDecorator
</param-value>
</context-param>
<context-param>
<param-name>facelets.RESOURCE_RESOLVER</param-name>
<param-value>
oracle.adfinternal.view. faces.facelets.rich.AdfFaceletsResourceResolver
</param-value>
</context-param>
<filter>
<filter-name>trinidad</filter-name>
<filter-class>org.apache.myfaces.trinidad.webapp.TrinidadFilter</filter-class>
</filter>
<filter-mapping>
<filter-name>trinidad</filter-name>
<servlet-name>Faces Servlet</servlet-name>
<dispatcher>FORWARD</dispatcher>
<dispatcher>REQUEST</dispatcher>
</filter-mapping>
<servlet>
<servlet-name>Faces Servlet</servlet-name>
<servlet-class>javax.faces.webapp.FacesServlet</servlet-class>
<load-on-startup>1</load-on-startup>
</servlet>
<servlet>
<servlet-name>resources</servlet-name>
<servlet-class>
org.apache.myfaces.trinidad.webapp.ResourceServlet
</servlet-class>
</servlet>
<servlet>
<servlet-name>BIGRAPHSERVLET</servlet-name>
<servlet-class>
oracle.adfinternal.view.faces.bi.renderkit.graph.GraphServlet
</servlet-class>
</servlet>
<servlet>
<servlet-name>BIGAUGESERVLET</servlet-name>
<servlet-class>
oracle.adfinternal.view.faces.bi.renderkit.gauge.GaugeServlet
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</servlet-class>

</servlet>

<servlet>
<servlet-name>MapProxyServlet</servlet-name>
<servlet-class>

oracle.adfinternal.view.faces.bi.renderkit.geoMap.servlet.MapProxyServlet

</servlet-class>

</servlet>

<servlet>
<servlet-name>GatewayServlet</servlet-name>
<servlet-class>

oracle.adfinternal.view.faces.bi.renderkit.graph.FlashBridgeServlet

</servlet-class>

</servlet>

<servlet-mapping>
<servlet-name>Faces Servlet</servlet-name>
<url-pattern>/faces/*</url-pattern>

</servlet-mapping>

<servlet-mapping>
<servlet-name>resources</servlet-name>
<url-pattern>/adf/*</url-pattern>

</servlet-mapping>

<servlet-mapping>
<servlet-name>resources</servlet-name>
<url-pattern>/afr/*</url-pattern>

</servlet-mapping>

<servlet-mapping>
<servlet-name>BIGRAPHSERVLET</servlet-name>
<url-pattern>/servlet/GraphServlet/*</url-pattern>

</servlet-mapping>

<servlet-mapping>
<servlet-name>BIGAUGESERVLET</servlet-name>
<url-pattern>/servlet/GaugeServlet/*</url-pattern>

</servlet-mapping>

<servlet-mapping>
<servlet-name>MapProxyServlet</servlet-name>
<url-pattern>/mapproxy/*</url-pattern>

</servlet-mapping>

<servlet-mapping>
<servlet-name>resources</servlet-name>
<url-pattern>/bi/*</url-pattern>

</servlet-mapping>

<servlet-mapping>
<servlet-name>GatewayServlet</servlet-name>
<url-pattern>/flashbridge/*</url-pattern>

</servlet-mapping>

</web-app>

An entry is also created in the faces-config.xml file for the view handler, as
shown in Example 2-14.

Example 2-14 Generated faces-config.xml File for an XHTML Page

<?xml version="1.0" encoding="windows-1252"7?>
<faces-config version="1.2" xmlns="http://java.sun.com/xml/ns/javaee">
<application>
<default-render-kit-id>oracle.adf.rich</default-render-kit-id>
</application>
</faces-config>
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An entry in the trinidad-config.xml file defines the default skin used by the user
interface (UI) components in the application, as shown in Example 2-15.

Example 2-15 Generated trinidad-config.xml File

<?xml version="1.0" encoding="windows-1252"?>

<trinidad-config xmlns="http://myfaces.apache.org/trinidad/config">
<skin-family>fusion</skin-family>

</trinidad-config>

When the page is first displayed in JDeveloper, it is displayed in the visual editor
(accessed by clicking the Design tab), which allows you to view the page in a
WYSIWYG environment. You can also view the source for the page in the source editor
by clicking the Source tab. The Structure window located in the lower left-hand corner
of JDeveloper, provides a hierarchical view of the page.

2.4.6 How to Add ADF Faces Components to JSF Pages

Once you have created a page, you can use the Component Palette to drag and drop
components onto the page. JDeveloper then declaratively adds the necessary page
code and sets certain values for component attributes.

Tip: For detailed procedures and information about adding and
using specific ADF Faces components, see Part III, "Using ADF Faces
Components".

Note: You cannot use ADF Faces components on the same page as
MyFaces Trinidad components (tr: tags) or other AJAX-enabled
library components. You can use Trinidad HTML tags (trh:) on the
same page as ADF Faces components, however you may experience
some browser layout issues. You should always attempt to use only
ADF Faces components to achieve your layout.

Note that your application may contain a mix of pages built using
either ADF Faces or other components.

To add ADF Faces components to a page:
1. In the Application Navigator, double click a JSF page to open it in the editor.

2. If the Component Palette is not displayed, from the menu choose View >
Component Palette. By default, the Component Palette is displayed in the upper
right-hand corner of JDeveloper.

3. In the Component Palette, use the dropdown menu to choose ADF Faces.

The components are contained in three accordion panels: Common Components,
Layout, and Operations. Figure 2-8 shows the Component Palette displaying the
Common Components for ADF Faces.
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Figure 2-8 Component Palette in JDeveloper
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4. Select the component you wish to use and drag it onto the page.

JDeveloper redraws the page in the visual editor with the newly added
component. In the visual editor, you can directly select components on the page
and use the resulting context menu to add more components. Figure 2-9 shows a
page in the visual editor.

2-22 Web User Interface Developer's Guide for Oracle Application Development Framework



Creating a View Page

Figure 2-9 Page Displayed in the Visual Editor
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Tip: You can also drag and drop components from the palette into
the Structure window or directly into the code in the source editor.

You can always add components by directly editing the page in the
source editor. To view the page in the source editor, click the Source
tab at the bottom of the window.

2.4.7 What Happens When You Add Components to a Page

When you drag and drop components from the Component Palette onto a JSF page,
JDeveloper adds the corresponding code to the JSF page. This code includes the tag
necessary to render the component, as well as values for some of the component
attributes. Example 2-16 shows the code when you drop an Input Text and a Button
component from the palette.

Example 2-16 JDeveloper Declaratively Adds Tags to a JSF Page

<af:inputText label="Label 1" id="itl"/>
<af:commandButton text="commandButton 1" id="cb"/>

Note: If you chose to use automatic component binding, then
JDeveloper also adds the binding attribute with its value bound to
the corresponding property on the page’s backing bean. For more
information, see Section 2.4.3, "What You May Need to Know About
Automatic Component Binding."

When you drop a component that contains mandatory child components (for example
a table or a list), JDeveloper launches a wizard where you define the parent and also
each of the child components. Figure 2-10 shows the Table wizard used to create a
table component and the table’s child column components.

Getting Started with ADF Faces 2-23



Creating a View Page

Figure 2-10 Table Wizard in JDeveloper
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Example 2-17 shows the code created when you use the wizard to create a table with
three columns, each of which uses an outputText component to display data.

Example 2-17 Declarative Code for a Table Component

<af:table var="row" id="tl">
<af:column sortable="false" headerText="coll" id="cl">
<af:outputText value="#{row.coll}" id="otl"/>
</af:column>
<af:column sortable="false" headerText="col2" id="c2">
<af:outputText value="#{row.col2}" id="ot2"/>
</af:column>
<af:column sortable="false" headerText="col3" id="c3">
<af:outputText value="#{row.col3}" id="ot3"/>
</af:column>
</af:table>

2.4.8 How to Set Component Attributes

Once you drop components onto a page you can use the Property Inspector (displayed
by default at the bottom right of JDeveloper) to set attribute values for each
component.

Tip: If the Property Inspector is not displayed, choose View >
Property Inspector from the main menu.

Figure 2-11 shows the Property Inspector displaying the attributes for an inputText
component.
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Figure 2-11 JDeveloper Property Inspector

@Input Text - #{explorerBundle[*file... E]

G -t ) 3@
= Common
o Id: |Fi|eName | v
Rendered: |<deFauIt> (true) v| w
B Label: |#{explorerBundIe['FiIeproperties.n v | w
@ value: #{newFiIeItem.nameH B
Appearance

Style
Behavior

Advanced

The Property Inspector has sections that group similar properties together. For
example, the Property Inspector groups commonly used attributes for the inputText
component in the Common section, while properties that affect how the component
behaves are grouped together in the Behavior section. Figure 2-12 shows the Behavior

section of the Property Inspector for an inputText component.

Figure 2-12 Behavior Section of the Property Inspector
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To set component attributes:

1. Select the component, in the visual editor, in the Structure window, or by selecting

the tag directly in the source editor.

2. In the Property Inspector, expand the section that contains the attribute you wish

to set.

Tip: Some attributes are displayed in more than one section.
Entering or changing the value in one section will also change it in
any other sections. You can search for an attribute by entering the

attribute name in the search field at the top of the inspector.

3. Either enter values directly into the fields, or if the field contains a dropdown list,
use that list to select a value. You can also use the dropdown to the right of the
field, which launches a popup containing tools you can use to set the value. These
tools are either specific property editors (opened by choosing Edit) or the
Expression Builder, which you can use to create EL expressions for the value
(opened by choosing Expression Builder). For more information about using the
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Expression Builder, see Section 2.5, "Creating EL Expressions." This popup also
displays a description of the property, as shown in Figure 2-13.

Figure 2-13 Property Tools and Help
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2.4.9 What Happens When You Use the Property Inspector

When you use the Property Inspector to set or change attribute values, JDeveloper
automatically changes the page source for the attribute to match the entered value.

Tip: You can always change attribute values by directly editing the
page in the source editor. To view the page in the source editor, click
the Source tab at the bottom of the window.

2.5 Creating EL Expressions

You use EL expressions throughout an ADF Faces application to bind attributes to
object values determined at runtime. For example, # {UserList.selectedUsers}
might reference a set of selected users, # {user.name} might reference a particular
user's name, while # {user.role == 'manager'} would evaluate whether a user is
a manager or not. At runtime, a generic expression evaluator returns the List,
String, and boolean values of these respective expressions, automating access to
the individual objects and their properties without requiring code.

At runtime, the value of certain JSF Ul components (such as an inputText
component or an outputText component) is determined by its value attribute.
While a component can have static text as its value, typically the value attribute will
contain an EL expression that the runtime infrastructure evaluates to determine what
data to display. For example, an outputText component that displays the name of
the currently logged-in user might have its value attribute set to the expression
#{UserInfo.name}. Since any attribute of a component (and not just the value
attribute) can be assigned a value using an EL expression, it's easy to build dynamic,
data-driven user interfaces. For example, you could hide a component when a set of
objects you need to display is empty by using a boolean-valued expression like # {not
empty UserList.selectedUsers} in the Ul component's rendered attribute. If
the list of selected users in the object named UserList is empty, the rendered
attribute evaluates to false and the component disappears from the page.

In a typical JSF application, you would create objects like UserList as a managed
bean. The JSF runtime manages instantiating these beans on demand when any EL
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expression references them for the first time. When displaying a value, the runtime
evaluates the EL expression and pulls the value from the managed bean to populate
the component with data when the page is displayed. If the user updates data in the
UI component, the JSF runtime pushes the value back into the corresponding managed
bean based on the same EL expression. For more information about creating and using
managed beans, see Section 2.6, "Creating and Using Managed Beans." For more
information about EL expressions, see the Java EE 5 tutorial at
http://java.sun.com.

2.5.1 How to Create an EL Expression

You can create EL expressions declaratively using the JDeveloper Expression Builder.
You can access the builder from the Property Inspector.

To use the Expression Builder:

1. In the Property Inspector, locate the attribute you wish to modify and use the right
most dropdown menu to choose Expression Builder.

2. Create expressions using the following features:

= Use the Variables tree to select items that you want to include in the
expression. The tree contains a hierarchical representation of the binding
objects. Each icon in the tree represents various types of binding objects that
you can use in an expression.

To narrow down the tree, you can either use the dropdown filter or enter
search criteria in the search field. The EL accessible objects exposed by ADF
Faces are located under the adfFacesContext node, which is under the JSF
Managed Beans node, as shown in Figure 2-14.

Figure 2-14 adfFacesContext Objects in the Expression Builder
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Tip: For more information about these objects, see the ADF Faces
Javadoc.

Selecting an item in the tree causes it to be moved to the Expression box
within an EL expression. You can also type the expression directly in the
Expression box.

= Use the operator buttons to add logical or mathematical operators to the
expression.

Figure 2-15 shows the Expression Builder dialog being used to create an
expression that binds to the value of a label for a component to the label
property of the explorer managed bean.

Figure 2-15 The Expression Builder Dialog
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2.5.2 How to Use EL Expressions Within Managed Beans

While JDeveloper creates many needed EL expressions for you, and you can use the
Expression Builder to create those not built for you, there may be times when you need
to access, set, or invoke EL expressions within a managed bean.

Example 2-18 shows how you can get a reference to an EL expression and return (or
create) the matching object.

Example 2-18 Resolving an EL Expression from a Managed Bean

public static Object resolveExpression(String expression) {
FacesContext facesContext = getFacesContext();
Application app = facesContext.getApplication();
ExpressionFactory elFactory = app.getExpressionFactory();
ELContext elContext = facesContext.getELContext();
ValueExpression valueExp =
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elFactory.createValueExpression (elContext, expression,
Object.class);
return valueExp.getValue (elContext) ;

Example 2-19 shows how you can resolve a method expression.

Example 2-19 Resolving a Method Expression from a Managed Bean

public static Object resloveMethodExpression(String expression,

Class returnType,
Class[] argTypes,
Object[] argValues) {

FacesContext facesContext = getFacesContext();

Application app = facesContext.getApplication();

ExpressionFactory elFactory = app.getExpressionFactory();

ELContext elContext = facesContext.getELContext();

MethodExpression methodExpression =

elFactory.createMethodExpression (elContext, expression, returnType,
argTypes) ;
return methodExpression.invoke (elContext, argValues);

Example 2-20 shows how you can set a new object on a managed bean.

Example 2-20 Setting a New Object on a Managed Bean

public static void setObject (String expression, Object newValue) {

FacesContext facesContext = getFacesContext();

Application app = facesContext.getApplication();

ExpressionFactory elFactory = app.getExpressionFactory();

ELContext elContext = facesContext.getELContext();

ValueExpression valueExp =
elFactory.createValueExpression (elContext, expression,

Object.class);

//Check that the input newValue can be cast to the property type
//expected by the managed bean.
//Rely on Auto-Unboxing if the managed Bean expects a primitive
Class bindClass = valueExp.getType (elContext) ;
if (bindClass.isPrimitive() || bindClass.isInstance(newValue)) {
valueExp.setValue (elContext, newValue);

2.6 Creating and Using Managed Beans

Managed beans are Java classes that you register with the application using various
configuration files. When the JSF application starts up, it parses these configuration
files and the beans are made available and can be referenced in an EL expression,
allowing access to the beans’ properties and methods. Whenever a managed bean is
referenced for the first time and it does not already exist, the Managed Bean Creation
Facility instantiates the bean by calling the default constructor method on the bean. If
any properties are also declared, they are populated with the declared default values.

Often, managed beans handle events or some manipulation of data that is best
handled at the front end. For a more complete description of how managed beans are
used in a standard JSF application, see the Java EE 5 tutorial on Sun’s web site
(http://java.sun.com).
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Best Practice: Use managed beans to store only bookkeeping
information, for example the current user. All application data and
processing should be handled by logic in the business layer of the
application.

In a standard JSF application, managed beans are registered in the
faces-config.xml configuration file.

Note: If you plan on using Oracle ADF Model data binding and ADF
Controller, then instead of registering managed beans in the
faces-config.xml file, you may need to register them within ADF
task flows. For more information, refer to the "Using a Managed Bean
in a Fusion Web Application” section of the Oracle Fusion Middleware
Fusion Developer's Guide for Oracle Application Development Framework.

2.6.1 How to Create a Managed Bean in JDeveloper

You can create a managed bean and register it with the JSF application at the same
time using the overview editor for the faces-config.xml file.

To create and register a managed bean:
1. Inthe Application Navigator, open the faces-config.xml file.

2. In the editor window, click the Overview tab.
3. In the overview editor, click the Managed Beans tab.

Figure 2-16 shows the editor for the faces-config.xml file used by the ADF
Faces demo that contains the File Explorer application.

Figure 2-16 Managed Beans in the faces-config.xml File
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4. Click the Add icon to add a row to the Managed Bean table.

5. In the Create Managed Bean dialog, enter values. Click Help for more information
about using the dialog. Select the Generate Class If It Does Not Exist option if
you want JDeveloper to create the class file for you.
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6. You can optionally add managed properties for the bean. When the bean is
instantiated, any managed properties will be set with the provided value. With the
bean selected in the Managed Bean table, click the New icon to add a row to the
Managed Properties table. In the Property Inspector, enter a property name (other
fields are optional).

Note: While you can declare managed properties using this editor,
the corresponding code is not generated on the Java class. You must
add that code by creating private member fields of the appropriate
type, and then by choosing the Generate Accessors menu item on the
context menu of the code editor to generate the corresponding get
and set methods for these bean properties.

2.6.2 What Happens When You Use JDeveloper to Create a Managed Bean

When you create a managed bean and elect to generate the Java file, JDeveloper
creates a stub class with the given name and a default constructor. Example 2-21
shows the code added to the MyBean class stored in the view package.

Example 2-21 Generated Code for a Managed Bean

package view;

public class MyBean {
public MyBean() {
}

}

You now must add the logic required by your page. You can then refer to that logic
using an EL expression that refers to the managed-bean-name given to the managed
bean. For example, to access the myInfo property on the my_bean managed bean, the
EL expression would be:

#{my_bean.myInfo}

JDeveloper also adds a managed-bean element to the faces-config.xml file.
Example 2-22 shows the managed-bean element created for the MyBean class.

Example 2-22 Managed Bean Configuration on the faces-config.xml File

<managed-bean>
<managed-bean-name>my_bean</managed-bean-name>
<managed-bean-class>view.MyBean</managed-bean-class>
<managed-bean-scope>session</managed-bean-scope>
</managed-bean>

2.7 Viewing ADF Faces Source Code and Javadoc

You can view the ADF Faces Javadoc directly from JDeveloper.

To view Javadoc for a class:
1. From the main menu, choose Navigate > Go to Javadoc.

2. In the Go to Javadoc dialog, enter the class name you want to view. If you don’t
know the exact name, you can either begin to type the name and JDeveloper will
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provide a list of classes that match the name. ADF Faces components are in the
oracle.adf.view.rich package.

Tip: When in a Java class file, you can go directly to the Javadoc for a

class name reference or for a JavaScript function call by placing your
cursor on the name or function and pressing Ctrl+D.
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Part II contains the following chapters:

Chapter 3, "Using ADF Faces Architecture"

Chapter 4, "Using the JSF Lifecycle with ADF Faces"
Chapter 5, "Handling Events"
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Chapter 7, "Rerendering Partial Page Content"
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Using ADF Faces Architecture

This chapter outlines the major ADF Faces architecture features and also provides
information for using different features of the client-side architecture.

This chapter includes the following sections:

= Section 3.1, "Introduction to Using ADF Faces Architecture”

= Section 3.2, "Listening for Client Events"

= Section 3.3, "Adding JavaScript to a Page"

= Section 3.4, "Instantiating Client-Side Components"

= Section 3.5, "Locating a Client Component on a Page"

= Section 3.6, "Accessing Component Properties on the Client"

= Section 3.7, "Using Bonus Attributes for Client-Side Components"

= Section 3.8, "Understanding Rendering and Visibility"

3.1 Introduction to Using ADF Faces Architecture

The ADF Faces rich client framework (RCF) provides many of the features you need to
create AJAX-type functionality in your web application, all built into the framework. A
key aspect of the RCF is the sparsely populated client-side component model. Client
components exist only when they are required, either due to having a
clientListener handler registered on them, or because the page developer needs
to interact with a component on the client side and has specifically configured the
client component to be available.

The main reason client components exist is to provide an API contract for the
framework and for developers. You can think of a client-side component as a simple
property container with support for event handling. Because client components exist
only to store state and provide an AP]I, they have no direct interaction with the DOM
(document object model) whatsoever. All DOM interaction goes through an
intermediary called the peer. Most of the inner workings of the framework are hidden
from you. Using JDeveloper in conjunction with ADF Faces, you can use many of the
architectural features declaratively, without having to create any code.

For example, because RCF does not create client components for every server-side
component, there may be cases where you need a client version of a component
instance. Section 3.4, "Instantiating Client-Side Components," explains how to do this
declaratively. You use the Property Inspector in JDeveloper to set properties that
determine whether a component should be rendered at all, or simply be made not
visible, as described in Section 3.8, "Understanding Rendering and Visibility."
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Other functionality may require you to use the ADF Faces JavaScript APL For
example, Section 3.5, "Locating a Client Component on a Page," explains how to use
the API to locate a specific client-side component, and Section 3.6, "Accessing
Component Properties on the Client," documents how to access specific properties.

The following RCF features are more complex, and therefore have full chapters
devoted to them:

ADF Faces additions to the lifecycle: The ADF Faces framework extends the JSF
lifecycle, providing additional functionality, including a client-side value lifecycle.
For more information, see Chapter 4, "Using the JSF Lifecycle with ADF Faces."

Event handling: ADF Faces adheres to standard JSF event handling techniques. In
addition, the RCF provides AJAX-based rich postbacks (called partial page
rendering), as well as a client-side event model. For more information, see

Chapter 5, "Handling Events."

Conversion and validation: ADF Faces input components have built-in capabilities
to both convert and validate user entries. You can also create your own custom
converters and validators. For more information, see Chapter 6, "Validating and
Converting Input."

Partial page rendering: Partial page rendering (PPR) allows small areas of a page
to be refreshed without the need to redraw the entire page. Many ADF Faces
components have built-in PPR functionality. In addition, you can declaratively
configure PPR so that an action on one component causes a rerender of another.
For more information, see Chapter 7, "Rerendering Partial Page Content."

Geometry management: ADF Faces provides a number of layout components,
many of which support geometry management by automatically stretching their
contents to take up available space. For more information, see Chapter §,
"Organizing Content on Web Pages."

Messaging and help: The RCF provides the ability to display tooltips, messages,
and help for input components, as well as the ability to display global messages
for the application. The help framework allows you to create messages that can be
reused throughout the application.You create a help provider using a Java class, a
managed bean, an XLIFF file, or a standard properties file, or you can link to an
external HTML-based help system. For more information, see Chapter 17,
"Displaying Tips, Messages, and Help."

Hierarchical menu model: ADF Faces provides navigation components that render
items such as tabs and breadcrumbs for navigating hierarchical pages. The RCF
provides an XML-based menu model that, in conjunction with a metadata file,
contains all the information for generating the appropriate number of hierarchical
levels on each page, and the navigation items that belong to each level. For more
information, see Chapter 18, "Working with Navigation Components."

Reusable components: The RCF provides three reusable building blocks that can
be used by multiple pages in your application: page fragments that allow you to
create a part of a page (for example an address input form); page templates that
can provide a consistent look and feel throughout your application that can be
updated with changes automatically propagating to all pages using the template;
and declarative components that are composite components that developers can
reuse, ensuring consistent behavior throughout the application. For more
information, see Chapter 19, "Creating and Reusing Fragments, Page Templates,
and Components."

Applying skins: The RCF allows you to create your own look and feel by creating
skins used by the ADF Faces components to change their appearance. For more
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information, see Chapter 20, "Customizing the Appearance Using Styles and
Skins."

s Internationalization and localization: You can configure your JSF page or
application to use different locales so that it displays the correct language based on
the language setting of a user’s browser. For more information, see Chapter 21,
"Internationalizing and Localizing Pages."

»  Accessibility: ADF Faces components have built-in accessibility support for user
agents, for example a web browser rendering to nonvisual media such as a screen
reader or magnifier. Accessibility support also includes access keys that allow
users to access components and links using only the keyboard, and audit rules that
provide directions to create accessible images, tables, frames, forms, error
messages, and popup dialogs using accessible HTML markup. For more
information, see Chapter 22, "Developing Accessible ADF Faces Pages."

s User-driven personalization: Many ADF Faces components, such as the
panelSplitter, allow users to change the display of the component at runtime.
By default, these changes live only as long as the page request. However, you can
configure your application so that the changes can be persisted through the length
of the user’s session. For more information, see Chapter 31, "Allowing User
Customization on JSF Pages."

s Drag and drop capabilities: The RCF allows the user to move (cut and paste), copy
(copy and paste), or link (copy and paste as a link) data from one location to
another. When the drop is completed, the component accepting the drop rerenders
using partial page rendering. For more information, see Chapter 32, "Adding Drag
and Drop Functionality."

The remainder of this chapter focuses on working with the client-side framework.

3.2 Listening for Client Events

In a traditional JSF application, if you want to process events on the client, you must
listen to DOM-level events. However, these events are not delivered in a portable
manner. The ADF Faces client-side event model is similar to the JSF events model, but
implemented on the client. The client-side event model abstracts from the DOM,
providing a component-level event model and lifecycle, which executes independently
of the server. Consequently, you do not need to listen for c1ick events on buttons.
You can instead listen for AdfActionEvent events, which can be caused by key or
mouse events.

Events sent by clients are all subclasses of the AdfBaseEvent class. Each client event
has a source, which is the component that triggered the event. Events also have a type
(for example, action or dialog), used to determine which listeners are interested in
the event. You register a client listener on the component using the
af:clientListener tag.

For example, suppose you have a button that, when clicked, causes a "Hello World"
alert to be displayed. You would first register a listener with the button that will
invoke an event handler, as shown in Example 3-1.

Example 3-1 Registering a Client Listener

<af:commandButton text="Say Hello">
<af:clientListener method="sayHello" type="action"/>
</af:commandButton>
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Tip: Because the button has a registered client listener, the
framework will automatically create a client version of the
component.

Next, implement the handler in a JavaScript function, as shown in Example 3-2.

Example 3-2 JavaScript Event Handler

function sayHello(event)

{
alert ("Hello, world!")
}

When the button is clicked, because there is a client version of the component, the
AdfAction client event is invoked. Because a clientListener tag is configured to
listen for the AdfAction event, it causes the sayHello function to execute. For more
information about client-side events, see Section 5.3, "Using JavaScript for ADF Faces
Client Events."

3.3 Adding JavaScript to a Page

You can either add inline JavaScript directly to a page or you can import JavaScript
libraries into a page. When you import libraries, you reduce the page content size, the
libraries can be shared across pages, and they can be cached by the browser. You
should import JavaScript libraries whenever possible. Use inline JavaScript only for
cases where a small, page-specific script is needed.

Performance Tip: Including JavaScript only in the pages that need it
will result in better performance because those pages that do not need
it will not have to load it, as they would if the JavaScript were
included in a template. However, if you find that most of your pages
use the same JavaScript code, you may want to consider including the
script or the tag to import the library in a template.

Note, however, that if a JavaScript code library becomes too big, you
should consider splitting it into meaningful pieces and include only
the pieces needed by the page (and not in a template). This approach
will provide improved performance, because the browser cache will
be used and the HTML content of the page will be smaller.

3.3.1 How to Use Inline JavaScript

Create and use inline JavaScript in the same way you would in any JSF application.
Once the JavaScript is on the page, use a clientListener tag to invoke it.

To use inline JavaScript:

1. Add the MyFaces Trinidad tag library to the root element of the page by adding
the code shown in bold in Example 3-3.

Example 3-3 MyFaces Trinidad Tag Library on a Page

<jsp:root xmlns:jsp="http://java.sun.com/JSP/Page" version="2.1"
xmlns:f="http://java.sun.com/jsf/core"
xmlns:h="http://java.sun.com/jsf/html"
xmlns:af="http://xmlns.oracle.com/adf/faces/rich">
xmlns:trh="http://myfaces.apache.org/trinidad/html"
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2. Create the JavaScript on the page.

For example, the sayHello function shown in Example 3-2 might be included in
a JSF page as shown in Example 3—4.

Example 3—4 Inline JavaScript

<af:resource>
function sayHello()
{
alert("Hello, world!")
}

</af:resource>

Note: Do not use the f:verbatim tag in a page or template to
specify the JavaScript.

3. In the Structure window, right-click the component that will invoke the JavaScript,
and choose Insert inside component > ADF Faces > Client Listener.

4. In the Insert Client Listener dialog, in the Method field, enter the JavaScript
function name. In the Type field, select the event type that should invoke the
function.

3.3.2 How to Import JavaScript Libraries

Use the af : resource tag to access a JavaScript library from a page. This tag should
appear inside the document tag’s metaContainer facet.

To access a JavaScript library from a page:

1. Below the document tag, add the code shown in bold in Example 3-5 and replace
/mySourceDirectory with the relative path to the directory that holds the
JavaScript library.

Example 3-5 Accessing a JavaScript Library

<af:document>
<f:facet name="metaContainer">
<af:resource source="/mySourceDirectory"/>
</facet>
<af:form></af:form>
</af:document>

2. In the Structure window, right-click the component that will invoke the JavaScript,
and choose Insert inside component > ADF Faces > Client Listener.

3. In the Insert Client Listener dialog, in the Method field, enter the fully qualified
name of the function. For example, if the sayHello function was in the
MyScripts library, you would enter MyScripts. sayHello. In the Type field,
select the event type that should invoke the function.

3.3.3 What You May Need to Know About Accessing Client Event Sources

Often when your JavaScript needs to access a client, it is within the context of a listener
and must access the event’s source component. Use the get Source () method to get
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the client component. Example 3—6 shows the sayHello function accessing the source
client component in order to display its name.

Example 3-6 Accessing a Client Event Source

function sayHello(actionEvent)
{

var component=actionEvent.getSource();

//Get the ID for the component
var id=component.getId

alert ("Hello from "+id);

}

For more information about accessing client event sources, see Section 5.3, "Using
JavaScript for ADF Faces Client Events." For more information about accessing
client-side properties, see Section 3.6, "Accessing Component Properties on the Client."
For a complete description of how client events are handled at runtime, see

Section 5.3.6, "What Happens at Runtime: How Client-Side Events Work."

3.4 Instantiating Client-Side Components

The RCF does not make any guarantees about which components will have
corresponding client-side component instances by default. You will usually interact
with client-side components by registering a clientListener handler. When a
component has a registered clientListener handler, it will automatically have
client-side representation. If you have to access another component on the client, then
explicitly configure that component to be available on the client by setting the
clientComponent attribute to true.

Performance Tip: Only set clientComponent to true if you plan
on interacting with the component programmatically on the client.

When you set the clientComponent attribute to true, the framework creates an
instance of an AdfUIComponent class for the component. This class provides the API
that you can work with on the client side and also provides basic property accessor
methods (for example, getProperty () and setProperty ()), event listener
registration, and event delivery-related APIs. The framework also provides
renderer-specific subclasses (for example, AdfRichOutputText) which expose
property-specific accessor methods (for example, getText () and setText ()). These
accessor methods are simply wrappers around the AdfUIComponent class’s
getProperty () and setProperty () methods and are provided for coding
convenience.

For example, suppose you have an outputText component on the page that will get
its value (and therefore the text to display) from the sayHello function. That function
must be able to access the outputText component in order to set its value. For this to
work, there must be a client-side version of the outputText component. Example 3-7
shows the JSF page code. Note that the outputText component has an id value and
the clientComponent attribute is set to true. Also, note there is no value in the
example, because that value will be set by the JavaScript.

Example 3-7 Adding a Component

<af:commandButton text="Say Hello">
<af:clientListener method="sayHello" type="action"/>
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</af:commandButton>
<af:outputText id="greeting" value="" clientComponent="true">

Because the outputText component will now have client-side representation, the
JavaScript will be able to locate and work with it.

3.5 Locating a Client Component on a Page

When you need to find a client component that is not the source of an event, you can
use the AdfUIComponent . findComponent (expr) method. This method is similar
to the JSF UIComponent . findComponent () method, which searches for and returns
the UIComponent object with an ID that matches the specified search expression. The
AdfUIComponent . findComponent (expr) method simply works on the client
instead of the server.

Example 3-8 shows the sayHello function finding the outputText component
using the component’s ID.

Example 3-8 Finding a Client Component Using findComponent()

function sayHello(actionEvent)

{

var buttonComponent=actionEvent.getSource();

//Find the client component for the "greeting" af:outputText
var greetingComponent=buttonComponent.findComponent ("greeting") ;

//Set the value for the outputText component
greetingComponent.setValue ("Hello World")
}

Instead of using the AdfUIComponent . findComponent (expr) method, you can
use the AdfPage . PAGE. findComponentByAbsoluteld (absolute expr)
method when you know the absolute identifier for the component, but you don't have
a component instance to call AAfUIComponent . findComponent (expr) on.
AdfPage.PAGE is a global object that provides a static reference to the page's context
object. However, if the component you are finding is within a naming container, then
you must use AdfUIComponent . findComponent. For more information, see
Section 3.5.1, "What You May Need to Know About Finding Components in Naming
Containers."

Note: There is also a confusingly named

AdfPage.PAGE. findComponent (clientId) method, however
this function uses implementation-specific identifiers that can change
between releases and should not be used by page authors.

3.5.1 What You May Need to Know About Finding Components in Naming Containers

If the component you need to find is within a component that is a naming container
(such as pageTemplate, subform, table, and tree), then instead of using the
AdfPage.PAGE. findComponentByAbsoluteId (absolute expr) method, use
the AdfUIComponent. findComponent (expr) method. The expression can be
either absolute or relative.
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Tip: You can determine whether or not a component is a naming
container by reviewing the component tag documentation. The tag
documentation states whether a component is a naming container.

Absolute expressions use the fully qualified JSF client ID (meaning, prefixed with the
IDs of all NamingContainer components that contain the component) with a leading
NamingContainer.SEPARATOR_CHAR character, for example:

":" + (namingContainersToJumpUp * ":") + some ending portion of the
clientIdOfComponentToFind

For example, to find a table whose ID is t 1 that is within a panel collection component
whose ID is pcl contained in a region whose ID is r1 on page that uses the
myTemplate template, you might use the following:

:myTemplate:rl:pcl:tl

Alternatively, if both the components (the one doing the search and the one being
searched for) share the same NamingContainer component somewhere in the
hierarchy, you can use a relative path to perform a search relative to the component
doing the search. A relative path has multiple leading
NamingContainer.SEPARATOR_CHAR characters, for example:

":" + clientIdOfComponentToFind

In the preceding example, if the component doing the searching is also in the same
region as the table, you might use the following:

: :somePanelCollection:someTable

Tip: Think of a naming container as a folder and the clientIdasa
file path. In terms of folders and files, you use two sequential periods
and aslash (../) tomove up in the hierarchy to another folder.
This is the same thing that the multiple colon (: ) characters do in the
findComponent () expression. A single leading colon (: ) means
that the file path is absolute from the root of the file structure. If there
are multiple leading colon (:) characters at the beginning of the
expression, then the first one is ignored and the others are counted,
one set of periods and a slash (. . /) per colon (:) character.

When deciding whether to use an absolute or relative path, keep the following in
mind:

= If you know that the component you are trying to find will always be in the same
naming container, then use an absolute path.

s If you know that the component performing the search and the component you
are trying to find will always be in the same relative location, then use a relative
path.

There are no getChildren () or getFacet () functions on the client. Instead, the
AdfUIComponent.visitChildren () function is provided to visit all children
components or facets (that is all descendents). See the ADF Faces JavaScript
documentation for more information.
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3.6 Accessing Component Properties on the Client

For each built-in property on a component, convenience accessor methods are
available on the component class. For example, you can call the getvValue () method
on a client component and receive the same value that was used on the server.

Note: All client properties in ADF Faces use the getXyz function
naming convention including boolean properties. The isXyz naming
convention for boolean properties is not used.

Constants are also available for the property names on the class object. For instance,
you can use AdfRichDialog.STYLE_CLASS constant instead of using
"styleClass".

Note: In JavaScript, it is more efficient to refer to a constant than to
code the string, as the latter requires an object allocation on each
invocation.

When a component’s property changes, the end result should be that the component’s
DOM is updated to reflect its new state, in some cases without a roundtrip to the
server. The component's role in this process is fairly limited: it simply stores away the
new property value and then notifies the peer of the change. The peer contains the
logic for updating the DOM to reflect the new component state.

Note: Not all property changes are handled through the peer on the
client side. Some property changes are propagated back to the server
and the component is rerendered using PPR.

As noted in Section 1.2.2, "ADF Faces Architectural Features," most property values
that are set on the client result in automatic synchronization with the server (although
some complex Java objects are not sent to the client at all). There are however, two
types of properties that act differently: secured properties and disconnected properties.

Secured properties are those that cannot be set on the client at all. For example, say a
malicious client used JavaScript to set the immediate flag on a commandLink
component to true. That change would then be propagated to the server, resulting in
server-side validation being skipped, causing a possible security hole (for more
information about using the immediate property, see Section 4.2, "Using the
Immediate Attribute"). Consequently, the immediate property is a secured property.

Attempts to set any other secured property from JavaScript will fail. For more
information, see Section 3.6.2, "How to Unsecure the disabled Property." Table 3-1
shows the secure properties on the client components.

Table 3—-1 Secure Client Properties

Component Secure Property

AdfRichChooseColor colorData

AdfRichComboboxListOfvalue disabled
readOnly
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Table 3-1 (Cont.) Secure Client Properties

Component

Secure Property

AdfRichCommandButton

disabled
readOnly
blocking

AdfRichCommandImageLink

blocking
disabled
partialSubmit

AdfRichCommandLink

readOnly

AdfRichDialog

dialogListener

AdfRichDocument

failedConnectionText

AdfRichInputColor

disabled
readOnly

colorData

AdfRichInputDate

disabled
readOnly

valuePassThru

AdfRichInputFile

disabled
readOnly

AdfRichInputListOfvValues

disabled
readOnly

AdfRichInputNumberSlider

disabled
readOnly

AdfRichInputNumberSplinBox

disabled
readOnly
maximum
minimum

stepSize

AdfRichInputRangeSlider

disabled
readOnly

AdfRichInputText

disabled
readOnly

secret

AdfRichPopUp

launchPopupListener
model
returnPopupListener
returnPopupDatalistener

createPopupId

AdfRichUIQuery

conjunctionReadOnly
model
queryListener

queryOperationListener

Web User Interface Developer's Guide for Oracle Application Development Framework



Accessing Component Properties on the Client

Table 3—-1 (Cont.) Secure Client Properties

Component

Secure Property

AdfRichSelectBooleanCheckbox

disabled
readOnly

AdfRichSelectBooleanRadio

disabled
readOnly

AdfRichSelectManyCheckbox

disabled
readOnly

valuePassThru

AdfRichSelectManyChoice

disabled
readOnly

valuePassThru

AdfRichSelectManyListBox

disabled
readOnly

valuePassThru

AdfRichSelectManyShuttle

disabled
readOnly

valuePassThru

AdfRichSelectOneChoice

disabled
readOnly

valuePassThru

AdfRichSelectOneListBox

disabled
readOnly

valuePassThru

AdfRichSelectOneRadio

disabled
readOnly

valuePassThru

AdfRichSelectOrderShuttle

disabled
readOnly

valuePassThru

AdfRichUITable

filterModel

AdfRichTextEditor

disabled
readOnly

AdfUIChart

chartDrillDownListener

AdfUIColumn

sortProperty

AdfUICommand

actionExpression
returnListener
launchListener

immediate

AdfUIComponentRef

componentType
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Table 3-1 (Cont.) Secure Client Properties

Component

Secure Property

AdfUIEditableValueBase

immediate
valid
required
localvValueSet
submittedvalue

requiredMessageDetail

AdfUIMessage.js

for

AdfUINavigationLevel

level

AdfUINavigationTree

rowDisclosureListener
startLevel

immediate

AdfUIPage

rowDisclosureListener

immediate

AdfUIPoll

immediate

pollListener

AdfUIProgress

immediate

AdfUISelectBoolean

selected

AdfUISelectInput

actionExpression

returnListener

AdfUISelectRange

immediate

rangeChangelListener

AdfUIShowDetailBase

immediate

disclosureListener

AdfUISingleStep

selectedStep

maxstep

AdfUISubform

default

AdfUITableBase

rowDisclosureListener
selectionListener
immediate
sortListener
rangeChangelListener

showAll

AdfUITreeBase

immediate
rowDisclosureListener
selectionListener
focusRowKey

focusListener

AdfUITreeTable

rowsByDepth

rangeChangelListener

AdfUIValueBase

converter
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ADF Faces does allow you to configure the disabled property so that it can be made
unsecure. This can be useful when you need to use JavaScript to enable and disable
buttons. When you set the unsecure property to true, the disabled property (and
only the disabled property) will be made unsecure.

Disconnected properties are those that can be set on the client, but that do not propagate
back to the server. These properties have a lifecycle on the client that is independent of
the lifecycle on the server. For example, client form input components (like
AdfRichInputText)have a submittedValue property, just as the Java
EditableValueHolder components do. However, setting this property does not
directly affect the server. In this case, standard form submission techniques handle
updating the submitted value on the server.

A property can be both disconnected and secured. In practice, such properties act like
disconnected properties on the client: they can be set on the client, but will not be sent
to the server. But they act like secured properties on the server, in that they will refuse
any client attempts to set them.

3.6.1 How to Set Property Values on the Client

The RCF provides setXYZz convenience functions that provide calls to the
AdfUIComponent setProperty () function. The setProperty () function takes
the following arguments:

= Property name (required)

= New value (required)

3.6.2 How to Unsecure the disabled Property

You use the unsecured property to set the disabled property to be unsecure. You
need to manually add this property and the value of disabled to the code for the
component whose disabled property should be unsecure. For example, the code for
a button whose disabled property should be unsecured would be:

<af:commandButton text="commandButton 1" id="cbl" unsecure="disabled"/>

Once you set the unsecure attribute to disabled, a malicious JavaScript could
change the disabled attribute unwittingly. For example, say you have an expense
approval page, and on that page, you want certain managers to be able to only
approve invoices that are under $200. For this reason, you want the approval button to
be disabled unless the current user is allowed to approve the invoice.

If you did not set the unsecured attribute to disabled, the approval button would
remain disabled until a round-trip to the server occurs, where logic determines if the
current user can approve the expense. But because you want the button to display
correctly as the page loads the expense, say you set the unsecure attribute to
disabled. Now you can use JavaScript on the client to determine if the button should
be disabled. But now, any JavaScript (including malicious JavaScript that you have no
control over) can do the same thing.

To avoid this issue, you must ensure that your application still performs the same logic
as if the round-trip to the server had happened. In the expense report approval screen,
you might have JavaScript that checks that the amount is under $200, but you still
need to have the action for the approval button perform the logic on the server.
Adding the logic to the server ensures that the disabled attribute does not get changed
when it should not.
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Similarly, if you allow your application to be modified at runtime, and you allow users
to potentially edit the unsecure and/or the disabled attributes, you must ensure
that your application still performs the same logic as if the round-trip to the server had
occurred.

3.6.3 What Happens at Runtime: How Client Properties Are Set on the Client

Calling the setProperty () function on the client sets the property to the new value,
and synchronously fires a PropertyChangeEvent event with the new values (as
long as the value is different). Also, setting a property may cause the component to
rerender itself.

3.7 Using Bonus Attributes for Client-Side Components

In some cases you may want to send additional information to the client beyond the
built-in properties. This can be accomplished using bonus attributes. Bonus attributes
are extra attributes that you can add to a component using the clientAttribute
tag. For performance reasons, the only bonus attributes sent to the client are those
specified by clientAttribute.

The clientAttribute tag specifies a name/value pair that is added to the
server-side component's attribute map. In addition to populating the server-side
attribute map, using the clientAttribute tag results in the bonus attribute being
sent to the client, where it can be accessed through the
AdfUIComponent.getProperty ("bonusAttributeName") method.

The RCF takes care of marshalling the attribute value to the client. The marshalling
layer supports marshalling of a range of object types, including strings, booleans,
numbers, dates, arrays, maps, and so on. For more information on marshalling, see
Section 5.4.3, "What You May Need to Know About Marshalling and Unmarshalling
Data."

Performance Tip: In order to avoid excessive marshalling overhead,
use client-side bonus attributes sparingly.

Note: The clientAttribute tagshould be used only for bonus
(application-defined) attributes. If you need access to standard
component attributes on the client, instead of using the
clientAttribute tag, simply set the clientComponent attribute
to true. For more information, see Section 3.4, "Instantiating
Client-Side Components."

3.7.1 How to Create Bonus Attributes

You can use the Component Palette to add a bonus attribute to a component.

To create bonus attributes:

1. In the Structure window, select the component to which you would like to add a
bonus attribute.

2. In the Component Palette, from the Operations panel, drag and drop a Client
Attribute as a child to the component.

3. In the Property Inspector, set the Name and Value attributes.
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3.7.2 What You May Need to Know About Marshalling Bonus Attributes

Although client-side bonus attributes are automatically delivered from the server to
the client, the reverse is not true. That is, changing or setting a bonus attribute on the
client will have no effect on the server. Only known (nonbonus) attributes are
synchronized from the client to the server. If you want to send application-defined
data back to the server, you should create a custom event. For more information, see
Section 5.4, "Sending Custom Events from the Client to the Server."

3.8 Understanding Rendering and Visibility

All ADF Faces display components have two attributes that relate to whether or not
the component is displayed on the page for the user to see: rendered and visible.

The rendered attribute has very strict semantics. When rendered is set to false,
there is no way to show a component on the client without a roundtrip to the server.
To support dynamically hiding and showing page contents, the RCF adds the
visible attribute. When set to false, the component's markup is available on the
client but the component is not displayed. Therefore calls to the setVisible (true)
or setVisible (false) method will, respectively, show and hide the component
within the browser (as long as rendered is set to true), whether those calls happen
from Java or from JavaScript.

Performance Tip: You should set the visible attribute to false
only when you absolutely need to be able to toggle visibility without a
roundtrip to the server, for example in JavaScript. Nonvisible
components still go through the component lifecycle, including
validation.

If you do not need to toggle visibility only on the client, then you
should instead set the rendered attribute to false. Making a
component not rendered (instead of not visible) will improve server
performance and client response time because the component will not
have client-side representation, and will not go through the
component lifecycle.

Example 3-9 shows two outputText components, only one of which is rendered at a
time. The first outputText component is rendered when no value has been entered
into the inputText component. The second outputText component is rendered
when a value is entered.

Example 3-9 Rendered and Not Rendered Components

<af:panelGroupLayout layout="horizontal">
<af:inputText label="Input some text" id="input"
value="#{myBean. inputValue}"/>
<af:commandButton text="Enter"/>
</af :panelGroupLayout>
<af:panelGroupLayout layout="horizontal">
<af:outputLabel value="You entered:"/>
<af:outputText value="No text entered" id="outputl"
rendered="#{myBean.inputValue==null}"/>
<af:outputText value="#{myBean.inputvValue}"
rendered="#{myBean.inputValue !=null}"/>
</af :panelGroupLayout>

Provided a component is rendered in the client, you can either display or hide the
component on the page using the visible property.
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Example 3-10 shows how you might achieve the same functionality as shown in
Example 3-9, but in this example, the visible attribute is used to determine which
component is displayed (the rendered attribute is true by default, it does not need
to be explicitly set).

Example 3—10 Visible and Not Visible Components

<af:panelGroupLayout layout="horizontal">
<af:inputText label="Input some text" id="input"
value="#{myBean. inputValue}"/>
<af:commandButton text="Enter"/>
</af:panelGroupLayout>
<af:panelGroupLayout layout="horizontal">
<af:outputLabel value="You entered:"/>
<af:outputText value="No text entered" id="outputl"
visible="#{myBean.inputvValue==null}"/>
<af:outputText value="#{myBean.inputvValue}"
visible="#{myBean.inputValue !=null}"/>
</af :panelGroupLayout>

However, because using the rendered attribute instead of the visible attribute
improves performance on the server side, you may instead decide to have JavaScript
handle the visibility.

Example 3-11 shows the page code for JavaScript that handles the visiblity of the
components.

Example 3-11 Using JavaScript to Turn On Visibility

function showText ()

{
var outputl = AdfUIComponent.findComponent ("outputl")
var output2 = AdfUIComponent.findComponent ("output2")
var input = AdfUIComponent.findComponent ("input")

if (input.getValue() == "")
{
outputl.setVisible(true);

}

else

{
output?2.setVisible(true)
}

3.8.1 How to Set Visibility Using JavaScript

You can create a conditional JavaScript function that can toggle the visible attribute
of components.

To set visibility:

1. Create the JavaScript that can toggle the visibility. Example 3-11 shows a script
that turns visibility on for one outputText component if there is no value;
otherwise, the script turns visibility on for the other outputText component.

2. For each component that will be needed in the JavaScript function, expand the
Advanced section of the Property Inspector and set the ClientComponent
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attribute to true. This creates a client component that will be used by the
JavaScript.

3. For the components whose visibility will be toggled, set the visible attribute to
false.

Example 3-12 shows the full page code used to toggle visibility with JavaScript.

Example 3-12 JavaScript Toggles Visibility

<f:view>
<af:resource>
function showText ()
{
var outputl = AdfUIComponent.findComponent ("outputl")
var output2 = AdfUIComponent.findComponent ("output2")
var input = AdfUIComponent.findComponent ("input")

if (input.value == "")

{
outputl.setVisible(true);
}

else

{
output2.setVisible(true)
}

}
</af:resource>
<af:document>
<af:form>
<af:panelGroupLayout layout="horizontal">
<af:inputText label="Input some text" id="input"
value="#{myBean.inputValue}" clientComponent="true"
immediate="true"/>
<af:commandButton text="Enter" clientComponent="true">
<af:clientListener method="showText" type="action"/>
</af:commandButton>
</af :panelGroupLayout>
<af:panelGroupLayout layout="horizontal">
<af:outputLabel value="You entered:" clientComponent="false"/>
<af:outputText value="No text entered" id="outputl"
visible="false" clientComponent="true"/>
<af:outputText value="#{myBean.inputValue}" id="output2"
visible="false" clientComponent="true"/>
</af :panelGroupLayout>
</af:form>
</af:document>
</f:view>

3.8.2 What You May Need to Know About Visible and the isShowing Function

If the parent of a component has its visible attribute set to false, when the
isVisible function is run against a child component whose visible attribute is set
to true, it will return true, even though that child is not displayed. For example, say
you have a panelGroupLayout component that contains an outputText
component as a child, and the panelGroupLayout component’s visible attribute
is set to false, while the outputText component’s visible attribute is left as the
default (true). On the client, neither the panelGroupLayout nor the outputText
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component will be displayed, but if the isVisible function is run against the
outputText component, it will return true.

For this reason, the RCF provides the isShowing () function. This function will
return false if the component’s visible attribute is set to false, or if any parent of
that component has visible set to false.
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Using the JSF Lifecycle with ADF Faces

This chapter describes the JSF page request lifecycle and the additions to the lifecycle
from ADF Faces, and how to use the lifecycle properly in your application.

This chapter includes the following sections:

= Section 4.1, "Introduction to the JSF Lifecycle and ADF Faces"
= Section 4.2, "Using the Immediate Attribute"

= Section 4.3, "Using the Optimized Lifecycle"

»  Section 4.4, "Using the Client-Side Lifecycle"

»  Section 4.5, "Using Subforms to Create Regions on a Page"

= Section 4.6, "Object Scope Lifecycles"

»  Section 4.7, "Passing Values Between Pages"

4.1 Introduction to the JSF Lifecycle and ADF Faces

Because the ADF Faces rich client framework (RCF) extends the JSF framework, any
application built using the ADF Faces rich client framework uses the standard JSF
page request lifecycle. However, the ADF Faces framework extends that lifecycle,
providing additional functionality, such as a client-side value lifecycle, a subform
component that allows you to create independent submittable regions on a page
without the drawbacks (for example, lost user edits) of using multiple forms on a
single page, and additional scopes.

To better understand the lifecycle enhancements that the RCF delivers, it is important
that you understand the standard JSF lifecycle. This section provides only an overview.
For a more detailed explanation, refer to the JSF specification at
http://java.sun.com.

When a JSF page is submitted and a new page is requested, the JSF page request
lifecycle is invoked. This lifecycle handles the submission of values on the page,
validation for components on the current page, navigation to and display of the
components on the resulting page, as well as saving and restoring state. The JSF
lifecycle phases use a Ul component tree to manage the display of the faces
components. This tree is a runtime representation of a JSF page: each UI component
tag in a page corresponds to a Ul component instance in the tree. The FacesServlet
object manages the page request lifecycle in JSF applications. The FacesServlet
object creates an object called FacesContext, which contains the information
necessary for request processing, and invokes an object that executes the lifecycle.

Figure 4-1 shows the JSF lifecycle of a page request. As shown, events are processed
before and after each phase.
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Figure 4-1 Lifecycle of a Page Request in an ADF Faces Application

Faces Request > .
Restore View

|
Process events

'

Apply Request Values
|

Process events

'

Process Validations
|

’7 Process events

Update Moclel \Values
|

Process events

.

Invoke Application

Process events

v

Render Response - Faces Response .

-

If initial render or no data from subrnitted page
If validation fails

If actionSource component set to immediate

In a JSF application, the page request lifecycle is as follows:

= Restore View: The component tree is established. If this is not the initial rendering
(that is, if the page was submitted back to server), the tree is restored with the
appropriate state. If this is the initial rendering, the component tree is created and
the lifecycle jumps to the Render Response phase.

= Apply Request Values: Each component in the tree extracts new values from the
request parameters (using its decode method) and stores the values locally. Most
associated events are queued for later processing. If a component has its
immediate attribute set to true, then the validation, the conversion, and the
events associated with the component are processed during this phase. For more
information, see Section 4.2, "Using the Immediate Attribute."

»  Process Validations: Local values of components are converted from the input type
to the underlying data type. If the converter fails, this phase continues to
completion (all remaining converters, validators, and required checks are run), but
at completion, the lifecycle jumps to the Render Response phase.

If there are no failures, the required attribute on the component is checked. If the
value is true, and the associated field contains a value, then any associated
validators are run. If the value is true and there is no field value, this phase
completes (all remaining validators are executed), but the lifecycle jumps to the
Render Response phase. If the value is false, the phase completes, unless no
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